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1 Welcome to the World of TRAKTOR KONTROL S8!

 

Thank you for choosing TRAKTOR KONTROL S8.

What is TRAKTOR KONTROL S8?

TRAKTOR KONTROL S8 provides a direct tactile interface to TRAKTOR PRO's features and al-
lows you to achieve more with the controller hardware so you have to do less on your computer
screen.

Whether you intend to perform and remix live with TRAKTOR, use S8 as a stand-alone mixer
with turntables or CD decks or a combination of both; S8 has you covered!

S8 enables performance in various live situations, combining the power of computer-based
DJing with the immediacy and flow you need to focus on your audience.

1.1 What's new for TRAKTOR KONTROL S8 Users?
 

This chapter provides a quick overview on S8's feature enhancements and improvements intro-
duced with TRAKTOR 2.9.

New Stem Deck Flavor in TRAKTOR PRO

TRAKTOR 2.9.0 introduces a new Stem Deck which is capable of playing and mix-
ing .stem.mp4 files. Thanks to the Automatic Deck Flavor Switching that was introduced in
TRAKTOR 2.8.0, a Deck will automatically switch to Stem Deck whenever you load
a .stem.mp4 file. The Stem Deck functions identically to a Track Deck, but just has additional
sub-mix features for controlling the four Slot Volumes, Filters, and FX Sends for the Stem
Files.

Due to the large amount of data that must be read from a Stem File, it is currently neces-
sary that Stem Files are analyzed before loading into a Stem Deck. It is not possible to load
and play a Stem File before it has been analyzed. For more information on how to analyze
tracks or Stem Files, refer to the TRAKTOR Manual.
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Stem Support for TRAKTOR KONTROL S8

The TRAKTOR KONTROL S8 controller now natively supports Stem Decks. The S8 provide full
4-stem visualization of the Stems on the in-built displays, and the Performance Knobs, But-
tons, and Faders control the sub-mix of the stems (such as Slot Volumes, Slot Filters, and Slot
FX Sends).

For more information on how to use Stem Decks, refer to section ↑3.10, Mixing Stem Files us-
ing Stem Decks.

Stem and Remix Deck Sub-mix Controls in Controller Manager

The sub-mix controls for the Remix Deck have now been upgraded to Deck Common controls in
the Controller Manager. Controls like Slot Volume, Slot Filter, Slot Mute, and Slot FX Send
Amount are now located in “Deck Common > Sub-Mix”. When mapping a MIDI Controller to
these controls, these controls will now control a Stem Deck or Remix Deck, whichever type is
loaded. If you had MIDI Mappings for Remix Deck mix controls previous to this update, those
controls are now automatically mapped to the Deck Common Sub-mix controls for conven-
ience.

Stem file management in Browser

To support management of .stem.mp4 files, a new smart folder called “All Stems” is added to
the Browser Tree. All Stem files in the Track Collection can be found quickly by clicking on
this node in the Tree.

Performance Optimizations

Playback of Stems requires more resources from your computer, so the team implemented a
number of performance optimizations to TRAKTOR to reduce the overall CPU load. These opti-
mizations can be enjoyed even when not playing Stem Files.

1.2 Where to Start
 

TRAKTOR KONTROL S8 installation provides you with many information sources. These are in-
tended to be read in the following sequence to ensure easy access for users of all skill levels:

• TRAKTOR Getting Started

Welcome to the World of TRAKTOR KONTROL S8!
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• TRAKTOR Manual

• TRAKTOR KONTROL S8 Manual (this document)

Your First Stop: Getting Started

This document guides you through configuration of TRAKTOR to work with a hardware control-
ler by means of the Setup Wizard, as well as importing music into your Track Collection. After-
wards, it introduces you to TRAKTOR's basic concepts and workflows and helps you set up
your system correctly.

TRAKTOR Manual

The Manual helps you learn all of the workflows which make TRAKTOR a unique DJing solu-
tion. In addition to learning to use TRAKTOR's core features, this document gives advice on
working in various configurations; from using TRAKTOR in the most basic setup on its own to
integrating turntables, external DJ mixers and audio interfaces, as well as the SCRATCH exten-
sion.

Access the TRAKTOR manual via TRAKTOR's Help menu. The 'Open Manual...' entry will
open the Documentation sub-folder inside TRAKTOR's application folder.

TRAKTOR KONTROL S8 Manual

The S8 Manual picks up where controlling TRAKTOR features from the S8 are concerned. A
detailed tutorial section guides you through accessing the basics like loading tracks, mixing,
setting cue points, looping, and using Remix Decks from S8.

Next, a comprehensive Hardware Reference details each and every component you will en-
counter on the TRAKTOR KONTROL S8 controller. The later chapters of this manual provide
additional information on solving common issues, and the device's full technical specification.

CONTROLLER EDITOR Manual

Besides using S8 with the dedicated TRAKTOR software, you can also use it as a powerful and
highly versatile MIDI controller with any other MIDI-capable application or device. This is
made possible by the CONTROLLER EDITOR software, an application which allows you to as-
sign MIDI controller messages to S8's pads, knobs, faders and encoders. The CONTROL-
LER EDITOR is usually automatically installed during TRAKTOR's installation. For more infor-
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mation on this, please refer to the CONTROLLER EDITOR Manual available as a PDF file in
the Documentation subfolder of the CONTROLLER EDITOR installation folder on your hard
disk.

Other Online Resources

If you are experiencing problems related to your Native Instruments product that the supplied
documentation does not cover, there are several ways of getting help:

• Knowledge Base

• User Forum

• Technical Support

• Registration Support

You will find more information on these in chapters ↑8.1, Troubleshooting and ↑8.2, Getting
Help.

1.3 Manual Conventions
 

This section introduces you to the signage and text highlighting used in this manual. This man-
ual uses particular formatting to point out special facts and to warn you of potential issues.
The icons introducing these notes let you see what kind of information is to be expected:

Whenever this exclamation mark icon appears, you should read the corresponding note
carefully and follow the instructions and hints given there if applicable.

This light bulb icon indicates that a note contains useful extra information. This informa-
tion may often help you solve a task more efficiently, but does not necessarily apply to the
setup or operating system you are using; however, it's always worth a look.

Furthermore, the following formatting is used:

• Text appearing in (drop-down) menus (such as Open…, Save as… etc.) and paths to loca-
tions on your hard drive or other storage devices is printed in italics.

• Text appearing elsewhere (labels of buttons, controls, text next to checkboxes etc.) is
printed in blue. Whenever you see this formatting applied, you will find the same text ap-
pearing somewhere on the screen.
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• Text appearing on displays of the S8 controller is printed in light grey. Whenever you see
this formatting applied, you will find the same text on a controller display.

• Text appearing on labels of the hardware controller is printed in orange. Whenever you see
this formatting applied, you will find the same text on the controller.

• Important names and concepts are printed in bold.

• References to keys on your computer’s keyboard you’ll find put in square brackets (e.g.,
“Press [Shift] + [Enter]”).

► Single instructions are indicated by this play button type arrow.

→ Results of actions are indicated by this smaller arrow.

Naming Conventions

Throughout the documentation, we will refer to the TRAKTOR KONTROL S8 hardware control-
ler either as the controller or simply S8.

The TRAKTOR 2 software and TRAKTOR SCRATCH will be referred to as TRAKTOR.

Button Combinations and Shortcuts on Your Controller

Most instructions will use the “+” sign to indicate buttons (or buttons and pads) that must be
pressed simultaneously, starting with the button indicated first. E.g., an instruction such as:

“Press SHIFT + PLAY”

means:

1. Press and hold SHIFT.
2. While holding SHIFT, press PLAY and release it.
3. Release SHIFT.

FX Knobs and Buttons

Above each of the Displays, there's a row of FX knobs and FX buttons which aren't labeled.
Similarly, the knobs below the display are unlabeled, the buttons are all labeled ON. To differ-
entiate them, we'll refer to them as FX knobs 1-4 and FX buttons 1-4 for the elements above the
display and Performance knobs 1-4 and Performance buttons 1-4 beneath the display.

Welcome to the World of TRAKTOR KONTROL S8!
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Numbering scheme for FX and Performance controls

Display Buttons

On each side of a display, there are two buttons marked by a square icon. To differentiate
them from each other, we'll refer to them as depicted here:

Welcome to the World of TRAKTOR KONTROL S8!
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Numbering scheme for Display Buttons

Pads

Each Deck comes with eight multi color pads. Where necessary, we'll refer to them in this or-
der:

Numbering of the Pads in the PERFORMANCE section

Welcome to the World of TRAKTOR KONTROL S8!
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2 Using Your S8—Getting Started

 

This section will guide you through the most common tasks you will encounter during your
work with TRAKTOR KONTROL S8. Most of the tutorials included are workflow-oriented. They
start with the simplest tasks and progressively lead you to more complex operation, helping you
to become familiar with TRAKTOR KONTROL S8.

The tutorials presented here make use of the included demo tracks, which were automatically
copied to your hard disk during the TRAKTOR KONTROL S8 installation procedure. Therefore,
you can follow these tutorials even if you haven't imported your own music.

Although the S8 can be used as a stand-alone mixer, the tutorials here focus on using the de-
vice as the integrated controller for the TRAKTOR software on your computer. By the end of
this chapter you will be equipped with the fundamental knowledge to enjoy using your TRAK-
TOR KONTROL S8, and begin to uncover the creative opportunities it presents to your DJ ses-
sions.

General Prerequisites

We assume here that your TRAKTOR KONTROL S8 system is already up and running. If that's
not the case, please follow the instructions in the separate Setup Guide and return to this
chapter when you are ready.

In case you already changed some settings in TRAKTOR KONTROL S8 before you start with
these tutorials, we strongly recommend you to reset your TRAKTOR KONTROL S8 system to
the factory settings by doing the following:

1. In the TRAKTOR software, click the Help menu in the menu bar at the top of your screen
(on Mac OS X) or at the top of the window (on Windows), and select Help > Start Setup
Wizard.

2. In the window that opens, click Next to skip the setup screens.
3. On the YOUR TRAKTOR SETUP screen, click Finish at the bottom right corner without se-

lecting anything else.
⇨ Your TRAKTOR KONTROL S8 is now reset to the factory settings.

The tutorials presented here assume that TRAKTOR KONTROL S8 is in its default factory
state. If it’s not the case, we cannot guarantee that you will experience what is described here,
and as a result you might find it difficult to follow the instructions.
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2.1 Quick Overview of TRAKTOR KONTROL S8
 

This section briefly introduces S8’s main areas. The image below illustrates which areas of the
S8 control the respective areas in the TRAKTOR software.

Hardware Controller and Software side by side.

(1) Decks: S8 features two identically equipped Deck sections at the far left and right of the
unit. These give you hardware control over the software Decks in the TRAKTOR PRO software.
Active TRAKTOR Decks always work in one of the Deck modes, as either Track Deck, Remix
Deck or Live Input. The left hardware Deck section controls TRAKTOR's Decks A and C, the
right Deck section controls Decks B and D.

(2) FX Units: FX Units allow you to creatively process a track, ranging anywhere from just add-
ing reverb for a build-up to completely messing up a beat with stutter effects. For that pur-
pose, the TRAKTOR software offers a great selection of high-quality FX. These can easily be
configured from S8 and be controlled by the FX controls. The left FX Unit on the S8 will be
referred to as FX Unit 1 throughout this document, and the right FX Unit will be referred to as
FX Unit 2.

(3) Mixer: The 4-channel mixer is situated in the center of S8, and TRAKTOR's software inter-
face. When connected to TRAKTOR, the knobs in S8's mixer section control the corresponding
knobs on the software mixer.

Using Your S8—Getting Started
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2.2 Enabling Decks
 

By default, the Decks on your S8 are enabled after you start the TRAKTOR software for the
first time. If, however, the Decks are not enabled (in Direct Thru mode), proceed as follows to
enable the Decks.

The following images show disabled Decks:

Deck A in Direct Thru mode

Using Your S8—Getting Started
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Deck C in Direct Thru mode

To enable the Decks:

► Push the TRAKTOR buttons of each Deck.

→ The TRAKTOR buttons light up in orange indicating the Deck is now in TRAKTOR mode.

 
The displays read No Track Loaded indicating the corresponding Decks are enabled.
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The following images show enabled Decks:

Deck A enabled as Track Deck

Deck C enabled as Remix Deck

2.3 Using the Browser
 

This tutorial explains how to use the Browser to access your music library. You will learn how
to sort and preview your tracks in the Browser, and how to load tracks into Decks.

Using Your S8—Getting Started
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It is not possible to open the Browser on S8's left and right Decks simultaneously.

BROWSE Encoder, BACK Button, and Display section

2.3.1 Opening the Browser
 

To open the Browser:
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► Push the BROWSE encoder.

The Browser will be displayed in the display.

2.3.2 Scrolling through Music Folders
 

To scroll through music folders:
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► Rotate the BROWSE encoder. The selected entry will be highlighted in blue. The Browser
View shows your current location in the folder structure at the top of the display, e.g.
BROWSER>PLAYLIST>DEMO TRACKS.

To open folders and load tracks:

► Press the BROWSE encoder to open a folder.

► Press the BROWSE encoder to load a track.

To return to the previous folder:

► Press the BACK button.

To exit the Browser:

► Press the VIEW button. The display will return to Track view.
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2.3.3 Browsing using Touch Interactions
 

In addition to regular interactions with S8, you can perform touch interactions. However, to
use touch interactions when browsing, the touch sensitivity for the BROWSE encoder has to be
enabled:

1. Open the TRAKTOR Preferences.
2. Select the tab TRAKTOR KONTROL S8.
3. Enable the Touch Control Auto Open Browser on Touch.

→ The touch sensitivity is now enabled on the BROWSE encoder.

With touch sensitivity enabled the following touch interactions can be performed:

To open the Browser:

► Touch the BROWSE encoder. The Browser will be displayed in the respective display.

To exit the Browser:

► Release the BROWSE encoder or stop interacting in the Browser. The display will return
to Track view.

2.3.4 Preview Tracks
 

In the Browser of the TRAKTOR KONTROL S8 it is possible to preview tracks directly.

To preview a selected track:
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1. Press the ON button 4 to start preview. The preview is now audible in the headphones.

2. Rotate Performance knob 4 to seek within the track in preview.

2.3.5 Sorting Tracks
 

To speed up scrolling through folders including a very large number of tracks, you can sort the
tracks by categories TITLE, ARTIST, BPM, IMPORT DATE, #, and KEY. The selected category is dis-
played at the bottom-left in the Browser.

To sort your tracks by another category:
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► Rotate Performance knob 1 until the desired category is selected in the SORT BY pop-up
window. The tracks will then be resorted.

Additionally, you can display the tracks in ascending or descending order:

► Press the ON button 1 to switch between ascending and descending order.

The Browser displaying tracks in descending order.
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The Browser displaying tracks in ascending order.

2.4 Playing Your First Track
 

In this tutorial, you will learn how to load and play back a track, how to check the audio out-
puts and how to quickly troubleshoot your system if no music can be heard. Before you pro-
ceed, ensure the following prerequisites are met:

Prerequisites

We assume your S8 is in the following state:

• The left Deck is focused on Track Deck A.

• The Channel A Crossfader Assign switch is set to the left position.
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• The Crossfader is set all the way to the left.

• On channel A, the channel fader is set to minimum, the EQ knobs, the GAIN knob, and
the Filter knob are set to center position.

• The MAIN knob is set to minimum.

2.4.1 Loading a Track
 

Let’s load the track “Techno 1” from the included demo tracks on to Deck A.

Since Deck A is in the top-left part of the TRAKTOR window, we will use the left Deck on your
S8. You can check this by looking at the left Deck’s display: you should see a blue indicator
reading A:
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The Deck Display with DECK A indicator.

While looking at the left Deck's display reading No Track Loaded. Push Browse Knob, do the following:

1. Press the BROWSE encoder of the left Deck to open the Browser.
2. Navigate to the folder FAVORITES > Demo Tracks.
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3. Scroll to track Techno 1.

4. Press the BROWSE encoder to load the track into Deck A.

→ The track is loaded. Its waveform and info appear in the display.

2.4.2 Playing a Track
 

Once a track is loaded:
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1. Press the PLAY button at the bottom of the left Deck. The PLAY button lights up.

 
The waveform starts moving in the display. The track is assigned to MASTER.

2. Gradually raise the channel A fader to maximum position.
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3. Gradually turn the MAIN knob clockwise.

→ You will hear the track Techno 1 playing back through your speakers. If not, please check
↑2.4.3, If You Don’t Hear the Track.

Each Deck Has Its Own Channel

The audio playing on each Deck can be further shaped by the controls on the corresponding
channel of the Mixer. Since the track is loaded on Deck A, you can control its sound on chan-
nel A:
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The Channel A.

2.4.3 If You Don’t Hear the Track
 

If the track is playing but the audio coming through your amplification system is not loud
enough, or if there is no sound at all, check the following:
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• At the bottom of your S8, verify that the Crossfader is moved all the way to the left:

• Above, the channel fader should be raised in channel A:
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• The channel meter should show some activity. If not, check that the HI, MID, and LOW
knobs in channel A are set to the center position. 

• At the top of the channel, adjust the input level by turning the GAIN knob.

• At the top center of the Mixer, the MAIN knob should be turned at least part of the way to
the right. You should see the MAIN meters moving:

 

If you see some activity on the MAIN meters of your S8 but don’t hear any sound, then double-
check the connection starting with the cable going from the S8’s Main Outputs to your PA.
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2.5 Mixing In a Second Track
 

Now that you have learned how to load and play a track from the S8, let’s mix in a second
track on Deck B. By doing so, you will learn a few mixing basics which are essential for every
DJ: how to cue tracks, synchronize tracks, start the playback at the right position, and mix the
tracks together using the Crossfader.

Prerequisites

We assume here that your S8 is in the following state:

• The track “Techno 1” is loaded into Deck A. The track is playing and audible.

• The right Deck is focused on Track Deck B.

• The Channel B Crossfader Assign switch is set to the right position.

• The Crossfader is all way to the left.
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• On channel B, the channel fader is set to minimum, the EQ knobs and the GAIN knob are
set to the center position.

• The CUE VOL knob and the CUE MIX knob are set to minimum.

2.5.1 Loading a Second Track
 

We will choose the track “Techno 2” and load it into the right Deck B, as we did for Deck A in
the previous tutorial.
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Track Deck B in its empty state.

While looking at the right Deck display reading "No Track Loaded, Touch Browse Knob", do the follow-
ing:

1. Press the BROWSE encoder of the right Deck to open the Browser. The Browser resumes
at the last selected item.
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2. Scroll to the track Techno 2.

3. Press the BROWSE encoder to load the track into Deck B.

→ The track is loaded. Its waveform and info appear in the display.

2.5.2 Playing the Second Track
 

► Press the PLAY button on the right Deck to start the playback.
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→ The track “Techno 2” starts playing. The PLAY button lights up and the waveform in the
display starts moving.

You don’t hear anything from Deck B through the speakers yet because the Crossfader on the
S8 is all the way to the left.

To mix in the track “Techno 2” on Deck B:

► Slowly move the Crossfader from left to right.

→ You should hear the track on Deck B fade in, whereas the track on Deck A progressively
fades out as you move the Crossfader further to the right.

If you followed the instructions above, the two tracks won't mix well, as they're not in sync. To
mitigate this, we have to beat-match the track in Deck B to the track playing on Deck A as
described in the following section. So for now:

Using Your S8—Getting Started

Mixing In a Second Track

 

TRAKTOR KONTROL S8 - Manual - 42



► Pull the Crossfader all the way back to the left.

If you still don’t hear any sound coming from Deck B even with the Crossfader all the way
to the right, check the troubleshooting guidelines in section ↑2.4.3, If You Don’t Hear the
Track.

2.5.3 Using Headphones to Prepare the Mix
 

Typically, a DJ needs to be able to prepare a mix on the headphone cue before committing to
it and sending it to the main out. This is how you use your headphones for the preparation on
S8:

1. Put on your headphones.
2. On your S8, press the CUE button on channel B. The button lights up, indicating that

Deck B is now sent to the CUE channel.

3. Gradually raise the CUE VOL knob.

→ You will hear the cued track in your headphones.
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Adjusting the balance between the cued track and main mix

For a great mix, you need to sync the affected Decks, match their levels and make sure that
the result sounds good. Use the Cue controls to adjust the balance between the cued track (in
this case Deck B) and the main mix (in this case Deck A) in your headphones:

► Turn the CUE MIX knob counterclockwise when you want to concentrate on the cued
track; turn it clockwise when you want to hear more of the main mix.

→ You are now ready to work on the track playing on Deck B without interfering with the
main mix sent to your audience.

Regardless of the mix that you’re hearing in your headphones, the main mix is still controlled
by the Crossfader and channel faders.

For smooth transitions, set the CUE MIX to the center position and adjust the cued Deck's
GAIN knob so that both sound equally loud.

 

2.5.4 Synchronizing the Second Track
 

Before mixing in the track playing on Deck B, we will use TRAKTOR’s automatic Sync feature
to adjust its tempo to that of Deck A. Since playback of Deck A was started first, it is automati-
cally assigned the role of Tempo MASTER. To sync Deck B to it:

► Press the SYNC button on the right Deck to synchronize its tempo and phase with those
of Deck A.
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→ The SYNC button lights up and the display of Deck B displays SYNC. Now the two tracks
are in perfect sync.

Cue the Track

► Slowly turn the CUE MIX knob clockwise.

→ You will hear the second track fade into the mix with both tracks in sync.

Note that you should always adjust the tempo of the cued track which is not audible to the
audience!

Mixing In the Second Track

When your track is ready for mixing:
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► Slowly move the Crossfader from the left to the right.

→ You just did your first mix with S8.

2.5.5 Interlude: In case the Left Track has finished
 

The track “Techno 1” on Deck A has been playing since we started with the tutorials, and it
might happen that the playback reaches the end of the track. In this case, just do the follow-
ing:

► On the left Deck, press Pad 1 to skip back to the beginning of the track.

You can then resume from where you left off.

2.5.6 Mixing In the Track by Using the Channel EQ and Filter
 

Besides simply using the Crossfader or channel volume faders to mix tracks, you can use
TRAKTOR KONTROL S8’s EQs and filters to make the mixes smoother and more interesting.
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The EQ and FILTER knobs on channel B.

Prerequisites

We assume here that you have already followed the instructions in the previous tutorials and
the S8 is in the following state:

• The track “Techno 1” is loaded on Deck A. The track is playing and audible.

• The track “Techno 2” is loaded on Deck B. The track is playing and audible.

• Both tracks are synched.

• The Crossfader is all the way to the left.

• On channel B, the channel fader is set to minimum, the EQ knobs, the GAIN knob, and
the Filter knob are set to center position.
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To prepare the cued track with EQ or Filter:

1. Put on your Headphones.
2. Enable CUE on channel B.

3. Press the FILTER button on Deck B.
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4. Turn any of the EQ or FILTER knobs on channel B to hear the effect on the cued track.

The EQs and filters are excellent tools for making adjustments to tracks before mixing them in
so that you get the smoothest transition possible. The most common technique is to filter the
bass line out of the incoming track—having 2 bass lines running simultaneously rarely sounds
good.

We will now carry out a first version of the mix “for real.” Thus, turn the CUE MIX knob
fully clockwise to hear the main mix in your headphones (or put off your phones and listen
to your mix coming through your amplification system).

Do the following:
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1. With the Crossfader still on the left, turn down the LOW knob on channel B to take the
bass out of the track on Deck B.

2. Progressively mix in channel B by gradually moving the Crossfader from the left to the
center position.

3. When both tracks are running together and you want to bring the bass back in, gradually
decrease the bass amount of channel A while simultaneously increasing that of channel
B.

4. Complete the transition by gradually moving the Crossfader all the way to the right.

→ You did your first mix using EQs and filters of your TRAKTOR KONTROL S8.
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2.6 Adjusting Levels
 

Before we continue with the tutorials, let's talk about the importance of setting your mix levels
correctly. We will provide a few simple hints which help you achieve the best sound with your
mix.

Even if this section looks a bit technical at first, please take the time to read these few pages,
as this knowledge will help you later on, especially in a live situation!

2.6.1 The Theory
 

By mixing, you blend together (and process) signals coming from multiple sound sources. The
mix is almost always louder than a single source. So it's important to keep levels within a safe
range.

As a basic rule, you will want to avoid signal clipping, while keeping them loud enough so you
use the full dynamic range available.

• If your signal exceeds the specified limits, it can't get any louder, but the sound quality is
degraded by digital distortion, called clipping. Clipping leads to scratchy, unpleasant
noises being added to the loudest signals in your mix. Although the music may appear
louder overall, it will lose its impact. Speakers will suffer from this—and so will your audi-
ence! (Also, be prepared for some annoyed sound technician or club owner coming down
on you.)

• If, on the other hand, you mix with very low levels, you will encounter the other extreme;
an elevated noise floor, especially apparent in quiet sections of your performance.

Hence, you should always make sure that your signals stay in the safe range.

2.6.2 In Practice
 

To assist you in adjusting levels, S8's Mixer is equipped with various level meters and controls.
Each level meter consists of a range of blue LEDs, indicating the safe signal range, along with
an orange LED at the top indicating the clipping.
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A channel meter clipping

In each channel, ensure that its channel meter shows a level in the upper range of the blue
LEDs when playing the loudest section of a track, only occasionally reaching the orange LEDs.
Letting your levels go “in the red” (or orange in this case) and using signal clipping to make
your mix sound dirtier is definitely not recommended: to do this, make use of TRAKTOR's great
FX selection instead!

Checking the Level on Each Channel

Each channel on the Mixer provides you with a vertical channel meter next to the fader. This
meter shows you the pre-fader level of the signal on that channel, i.e. the level of the signal
before it is adjusted by the channel fader. To adjust this level, use the GAIN knob at the very
top of the channel:

The GAIN knob sits at the top of each channel

► Adjust the channel’s GAIN knob so that the level displayed on the channel meter stays in
the upper part of the blue area without reaching the orange clipping LED.
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Note that the channel’s EQ and filter settings also affect the signal level, as well as the possi-
ble FX Unit(s) it is assigned to. Hence, when modifying any of these, you might need to re-
adjust the GAIN knob accordingly.

To get a good idea of the right levels to choose, we recommend you get to know the songs in
your set - for tracks with a variable level over time (e.g. a track starting with a soft intro), you
should base the level settings on the loudest section of the track.

Matching Levels Between Channels

Moreover, in order to avoid an audible level jump when cross-fading between two channels, the
perceived channel levels should match:

► Before mixing in a cued channel, adjust its GAIN knob so that its channel meter activity
roughly matches that of the channel currently on air.

TRAKTOR already does this for you by automatically applying a level balance value for each
newly loaded track. This so-called “Autogain” feature relies on the gain values extracted
from your tracks. Despite this automatism, depending on the particular EQ, filter and FX
applied to the cued track, you may want to double-check the level consistency before you
mix in the track. Moreover, what is important here is the perceived loudness of the specific
part of the track that you’re about to mix in.

Checking the Main Level in TRAKTOR

The signals coming from all channels are mixed together according to the relative levels deter-
mined by the channel faders and by the Crossfader. This mix is then sent from TRAKTOR’s
main output to the Main section:

The Main section on your S8
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In this section, the MAIN LEVEL meters show you the (left and right) overall level of your mix
after adjustment by the MAIN knob. Here, again, make sure not to exceed the safe range indi-
cated by blue LEDs too often.

For checking the level at the output of the TRAKTOR software, please refer to the meter in
TRAKTOR's header. Set the channel levels so that the mix mostly stays in the blue safe range
on the MAIN meter.

The MAIN meter showing too high levels in TRAKTOR's header.

By default, a limiter is enabled on TRAKTOR’s main output. With this limiter enabled, the
MAIN LEVEL meters’ clipping LEDs will cease to indicate clipping, but instead indicate when
the limiter kicks in. While the limiter prevents distortion inside TRAKTOR, the resulting con-
traction of the dynamic range cannot be undone. Therefore, even with the limiter enabled, en-
sure that the clipping LEDs don’t light up too often!

Setting the correct level on S8

Once correct levels are set in TRAKTOR, you can concentrate on working on the S8. Use the
MAIN knob to set the volume going to the speakers, again, so that your mix isn't clipping.

If turning up S8's MAIN knob doesn't give you satisfying levels, please check the channel
faders—they are probably set too low.

2.7 Switching Deck Focus
 

Although you can mix four TRAKTOR Decks with the S8, it is only possible to have the focus
on two of the Decks simultaneously. To access the respective other Decks, you have to switch
the Deck focus. In this example, toggle between Decks A and C by the following action:
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► Press the left DECK button to toggle between Deck A and Deck C.
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• If Deck A is focused, the DECK button, the Mode Select Button and the LED ring around
the LOOP encoder will be lit in blue.
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• If Deck C is focused, the DECK button, the Mode Select Button and the LED ring around
the LOOP encoder will be lit in white.
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2.8 Switching Deck View and Zooming
 

By default, the display shows only the focused Deck. This is called Single View. Additionally,
you can switch to Spilt View to show both Decks together in the display - Decks A and C on the
left side, Decks B and D on the right side. The display focused on just one Deck has the fol-
lowing appearance:

Deck A in Single View

► Press the View button located in the top-right corner of the display area to toggle Deck
View between Single View and Split View.

→ The display now shows both Decks in Split View.

The focused Deck always acquires the majority of space in the display.
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Split View with focus on Deck A.

Split View with focus on Deck C.

Changing Deck View does not change the Deck's focus.

Zooming

To get a more precise view of the waveform at the current Playhead position, you can zoom in
or out of the waveform.
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To zoom into the waveform:

► Press Display button 3 repeatedly until you reach the desired zoom level.

 

To zoom out of the waveform:
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► Press Display button 4 several times until you reach the desired zoom level.

 

2.9 Using Cue Points
 

This tutorial will explain how to work with HotCues for jumping directly to certain points within
a track. HotCues can be assigned to the pads when the Track Deck is in HOTCUE mode.

On a Track Deck in HOTCUE mode, pad 1 always represents the Start Cue Point that will be
assigned automatically as soon as a track is loaded. The remaining pads can be assigned with
further HotCues, as explained in the following section.
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Pad 1 as Start Cue Point.

Prerequisites

We assume here that you already followed the instructions in the previous tutorials (see ↑2.2,
Enabling Decks). TRAKTOR KONTROL S8 is in the following state:

• The track “Techno 1” is loaded on Deck A.

• The Deck A is set to HOTCUE mode (default state).

2.9.1 Setting and Deleting Cue Points (HotCues)
 

To set Cue Points within a track:
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► On the left Deck, whether or not the track is playing, press one of the unlit pads on a
downbeat—let’s say pad 2. The pad lights up blue.

→ You have just stored a Cue Point that you can return to by pressing the same pad again.

► In the display, a CuePoint will be highlighted by a blue indicator and the pad number.
You can store up to eight CuePoints per track, including the first which is automatically
set to the track start.

The highlighted CuePoint in the display.

To delete a Cue Point:
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► Press SHIFT + the pad assigned with a Cue Point.

→ The Cue point is deleted and the pad is unlit.

Snapping to the Beats

You don’t have to worry about being precise enough to set a HotCue directly on a beat; by de-
fault, TRAKTOR will make sure this happens automatically. This is because the Snap mode is
on, indicated by the lit S button located in the top-mid on the S8:

The S button on the Mixer.

With Snap mode on, any HotCue you set in the track will snap to the closest beat, thus ensur-
ing that recalling a CuePoint will always trigger a downbeat.

2.9.2 Aligning Tracks using HotCues
 

Aligning both tracks is straightforward:

1. Make sure that Deck B is playing.
1. When you hear a downbeat in the other track, press the pad with the HotCue you just

used to store the downbeat position.

→ The playback position on Deck B jumps to the stored Cue Point, and the playback contin-
ues from there. Both tracks now are perfectly aligned and ready to be mixed.

2.10 Adjusting Tempo
 

In this tutorial you will learn how to adjust the tempo of a track and the global tempo. The S8
doesn't feature a dedicated tempo fader per Deck which you might expect of a conventional DJ
controller. Instead, the S8 offers a new approach to controlling the tempo of your mixes descri-
bed in the following section.
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Prerequisites

We assume here that S8 is in the following state:

• The track “Techno 1” is loaded on Deck A and stopped.

• The track “Techno 2” is loaded on Deck B and stopped.

• The tracks are not in sync.

2.10.1 Global Tempo Adjustments
 

Global tempo adjustments are made using the TEMPO encoder located in the center of the S8.

The TEMPO encoder on the S8

Turning the TEMPO encoder will adjust the tempo of the assigned MASTER deck, along with any
other decks that have their SYNC buttons active. You can adjust the tempo in whole steps or in
decimal steps.
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Adjusting the Global Tempo

1. Press the PLAY button on Deck A. The Deck will be assigned to MASTER.

2. Turn the TEMPO encoder clockwise or counterclockwise to increase or decrease the tem-
po of TRAKTOR's Master Clock in decimal steps.
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3. Press any SHIFT button and turn the TEMPO encoder clockwise or counterclockwise to in-
crease or decrease the tempo of TRAKTOR's Master Clock in whole steps.

4. Release the Deck's SHIFT button.

→ The global tempo has changed.

2.10.2 Deck-specific tempo adjustments
 

Deck-specific tempo adjustments can be made by using BPM mode which will be enabled on
the Decks and the BROWSE encoders:
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Adjusting the Deck-specific Tempo

1. On a Deck press the Display Button 1.

The BPM pop-up becomes visible on the display.
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2. Turn the Deck's BROWSE encoder clockwise to increase the tempo; turn the Deck's
BROWSE encoder counterclockwise to decrease the tempo.

3. Hold the Deck's SHIFT button + turn the Deck's BROWSE encoder clockwise to increase
the tempo in whole steps; turn the Deck's BROWSE encoder counterclockwise to decrease
the tempo in whole steps.

4. Press the Display Button 1 again or press the View Button to close the BMP pop-up.

→ The Deck-specific tempo has changed.
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In this scenario, the BROWSE encoder has the same effect as the TEMPO encoder when mak-
ing tempo adjustments. If the Deck is assigned as the MASTER, tempo adjustments made with
the BROWSE encoder will also be applied to any other Deck with their SYNC button activated.

In scenarios where automatic Deck synchronization isn't possible, e.g. syncing a TRAKTOR
Deck with an external audio source, you can use this method to manually dial in a Deck's
BPM.

2.11 Using Keylock
 

When synchronizing tracks, you end up altering at least one track's tempo, which consequently
changes their pitch (or key). For small tempo adjustments, this mostly isn't going to be an is-
sue; but when the tempo is changed more significantly, the resulting pitch change might
sound unsuitable: kick sounds would lose their impact, vocals would sound unrealistic, har-
monic instruments would become dissonant when mixed, etc. To avoid issues like these,
TRAKTOR provides the Keylock feature which uncouples the pitch and the tempo of a track.
This allows you to basically lock the pitch while adjusting the tempo or vice versa. In order to
activate Keylock from the S8, do the following:

Prerequisites

We assume here that the S8 is in the following state:

• The track “Techno 1” is loaded on Deck A and playing.

Adjusting the Tempo and preserving the Original Pitch

If you want to mix a track in its original key to another track with a faster tempo, you need to
lock the key before adjusting the tempo of the track:
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1. On a Deck, press the Display Button 2.

The KEY pop-up opens on the display. For tracks which have been analyzed by TRAKTOR,
their key is displayed here.
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2. Press the Deck's BROWSE encoder to enable Keylock on the track. LOCK is now lit in
white.

3. Press the Display Button 2 again to exit the KEY pop-up in the display.
4. Now press Display Button 1 to open the BPM pop-up and adjust the track's tempo by turn-

ing the BROWSE encoder.

→ You can hear the tempo change, but the track's key remains intact.
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Adjusting the Key without changing Original Tempo

If you want to change just the key of a track without affecting its tempo, proceed as follows:

1. On a Deck, press the Display Button 2.

 
The KEY pop-up opens on the display. If the track has been analyzed by TRAKTOR, its key
will be displayed here.
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2. Press the Deck's BROWSE encoder to enable Keylock on the track. LOCK is now lit in
white. 

3. Now turn the Deck's BROWSE encoder to adjust the key of the track.

4. Press the Display Button 2 again to exit the KEY window in the display.

→ You will hear that the track's key has changed, while the tempo is preserved.
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3 Using Your S8—Getting Advanced

 

3.1 Using Touch Strip
 

S8 doesn't feature the conventional Jog Wheels of a regular DJ controller. Functions usually
associated with Jog Wheels are instead controlled by the intuitive Touch Strips. Each of S8's
Deck sections contains a Touch Strip, which always control just the focused Deck, indicated by
the DECK button's backlight color; Blue indicates a focus on a primary Deck (Decks A or B),
white indicates a focus on a secondary Deck (C or D). This tutorial explains how to use the
Touch Strip for the following actions:

• Seek/navigate through the entire track.

• Tempo bend (nudge).

• Scratching, backspinning and holding.

Prerequisites

We assume here that the S8 is in the following state:

• The track “Techno 1” is loaded on Deck A and is not playing.

• The Crossfader is set all the way to the left.

• The channel fader A is raised to the top.

• The MAIN knob is set at an adequate level.

3.1.1 Using Touch Strip to Seek
 

1. On the left Deck, press the PLAY button.
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2. While holding the Deck's SHIFT button, the LED strip above the recessed touch-sensitive
area will display this:

 
The LED segments represent the entire length of the track. The three orange segments
represent the current playhead position within the track.
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1. While holding SHIFT, place your finger on the Touch Strip beneath the orange LEDs and
swipe to the right to move forwards in the track's waveform.
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The three orange LEDs will follow your finger movement to the right, as does the playhead
in the waveform.
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2. Swipe your finger to the left to move backwards in the track's waveform.

 
The three orange LEDs will follow your finger movement to the left, just as the playhead in
the waveform.
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Alternatively, you can jump directly to an absolute position in the track by pressing SHIFT
+ placing your finger on the desired position on the Touch Strip.

3.1.2 Using Touch Strip to Nudge/Pitchbend
 

Traditional DJ's who don't have an automatic Sync function at hand are used to physically
nudging, twisting, and tweaking a conventional turntable with either Timecode vinyl or tradi-
tional vinyl to temporarily speed up or slow down a track and align the beats manually. The S8
allows you to work in a similar way by using the Touch Strip:

The LEDs above the Touch Strip provide visual information about a Deck's phase alignment.
They help you make the necessary tempo bend adjustments to get your tracks aligned.

The following tutorial will demonstrate how to manually beatmatch the two demo tracks "Tech-
no 1" loaded on Deck A and "Techno 2" loaded on Deck B by means of the Touch Strip, with-
out using the Sync function.

First step: Playing the Tracks

1. On Deck A press the PLAY button to start playback. The Deck will be assigned to MASTER.
2. On Deck B press the SYNC button to disable Sync. The SYNC button's backlight goes dim.
3. Listen to the track playing in Deck A, and press the PLAY button of deck B on an appropri-

ate downbeat to start playback.
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→ If your timing was perfect, a single orange LED at the center of the LED strip lights up,
indicating the phase-alignment of both tracks is correct.

 
If your timing was a little off, a few blue LEDs above the Touch Strip light up, indicating
the amount of phase-misalignment.

Second Step: Correcting phase-alignment

To correct the phase-alignment of both tracks, proceed as follows:

If blue LEDs are shown above the right side of the Touch Strip on the Deck not assigned to
MASTER:

► Swipe your finger toward the left side of the Touch Strip until the blue LEDs disappear
and a single orange LED is shown.

If blue LEDs are shown above the left side of the Touch Strip on the Deck not assigned to
MASTER:
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► Swipe your finger toward the right side of the Touch Strip until the blue LEDs disappear
and a single orange LED is shown.

→ The phase-alignment is corrected and both tracks are perfectly synched.
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3.1.3 Using the Touch Strip to Scratch and Backspin
 

Similar to manually turning a vinyl on a turntable, swiping a finger over the recessed Touch
Strip area allows you to create a scratch effect on a Track Deck or Remix Deck. This feature is
not enabled by default and requires some configuration as follows:

To enable the preference Touch to Scratch for the S8:

1. In the TRAKTOR window click File, then Preferences to open the preferences window.
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2. Navigate to the Traktor Kontrol S8 page, check the Shift + Touch to Scratch preference in
the Touchstrip section.
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3. Click Close to exit the Preferences window.

Performing Scratching

On the Deck:

1. Hold the SHIFT button.
2. On the Touch Strip swipe to the left. This will move the playhead slightly forwards in the

track's waveform, and you will hear the typical scratch effect.
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3. On the Touch Strip swipe to the right. This will move the playhead slightly backwards in
the track's waveform and you will hear the typical scratch effect.
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4. Try moving your finger across the Touch Strip (back and forth) to scratch the correspond-
ing playhead over a beat.

→ As soon as you cease moving your finger on the Touch Strip, the playhead remains at that
position.

A scratch effect can only be created when the track is stopped.

Performing a Backspin

On the Deck:

1. Hold the SHIFT button.
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2. On the Touch Strip swipe quickly from the very right to the very left. This will move the
playhead backward in the track's waveform, and you will hear the backspin effect.

→ As soon as you lift your finger from the Touch Strip, the playhead remains at that posi-
tion.

Backspins are enhanced by the fact that TRAKTOR will stop the spin as soon as you re-
lease the SHIFT button.

3.2 Playing with Loops in HOTCUE Mode
 

Now that we've covered all basic mixing techniques and how to use the Touch Strip, we will
focus on S8’s looping facilities in HOTCUE mode.
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Besides using the dedicated LOOP mode which will be explained in the next tutorial, you can
work with loops in default HOTCUE mode. This allows you to perform with HOTCUES and
loops at the same time.

Prerequisites

We assume here that the S8 is in the following state:

• The track “Techno 1” is loaded on Deck A and stopped.

• The Crossfader is all the way to the left.

• The channel fader A is raised to the top.

• The MAIN knob has an adequate level.

3.2.1 Engaging and Disengaging a Loop
 

Let’s add a loop to the track on Deck A.

To engage a loop on a Deck:

1. Press the Deck's PLAY button to start playback.
2. Press the Deck's HOTCUE button to enable HOTCUE mode.

3. Press the Deck's Loop encoder. The LED ring around the Loop encoder starts to rotate to
indicate the loop is activated.
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→ This will automatically add a loop at the current playback position in the track.

The example above shows an engaged loop of four beats. You can change the loop size while
the loop is active:
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► Turn the Deck's Loop encoder to change the loop size.

 
You can choose a loop size of 32 beats down to a loop size of 1/32 of a beat.

Note that you can adjust the loop size either before or after you’ve set the Loop! If you ad-
just the loop size beforehand, the next loop you set will acquire the set loop size value.

To deactivate the active Loop:

► Press the Loop encoder again.
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→ Playback continues as normal.

By pushing the Loop encoder when there is no Loop active, you activate looping: the next
Loop in the track will be activated.

3.2.2 Moving a Loop
 

With a loop size selected, you can move the Loop selection to another position within your
track.

To move the Loop:

► Press the Deck's SHIFT button and turn the Loop encoder. The loop selection will be
moved through the track on the fly and looping continues at the respective position.

The step size you move the selection by is the same as the loop size, which is shown in the
display.

Turning the Loop encoder when there is no Loop active lets you jump backward/forward
through the track by the same step size.
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3.2.3 Storing a Loop
 

In a previous tutorial, you learned how to store Cue Points, which is as simple as pressing an
unlit pad. Storing Loops works in a similar way. Let's say you have stored two HotCues in the
track currently playing:

1. Press the Loop encoder to engage a Loop.
2. To store the active Loop, press an unlit pad. The pad lights up green.
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The display will show a green marker indicating the Loop. The marker also shows the number
of the corresponding pad.

→ You have just stored a Loop that you can return to by pressing the same pad again.

Deleting a Loop

To delete a Loop:

► Press the Deck's SHIFT button and the pad assigned to the Loop you want to delete.

3.3 Playing with Loops in LOOP Mode
 

LOOP mode offers a different set of control options for using loops on track Decks and Remix
Decks, which you will learn in the following tutorial.

When LOOP mode is activated, the top row of pads light up in green and the bottom row of
pads light up in orange. The green pads represent four Loop sizes. The orange pads represent
Beatjump sizes.
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Pads illuminated in LOOP mode.

Prerequisites

We assume here that the S8 is in the following state:

• The track “Techno 1” is loaded on Deck A and is not playing.

• The Crossfader is all the way to the left.

• The channel fader A is raised to the top.

• The MAIN knob has an adequate level.

3.3.1 Looping with Pre-defined Sizes
 

In LOOP mode, with the first row of pads you can engage loops with pre-defined values. By
default, these are (from left to right) 1/8, 1/4, 1/2 or 1 beat.

To engage a loop:

1. Press the Deck's PLAY button to start playback.
2. Press the Deck's LOOP button to enable LOOP mode.

 
The LOOP button lights up brightly and the pads also illuminate.
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With a track playing and Loop mode enabled, you can perform the following actions:

► Press one of the green pads to engage a Loop of 1/8 beat, 1/4 beat, 1/2 beat, or 1 beat.
The LED ring around the Loop encoder starts to rotate indicating a loop is engaged.

► Press the same green pad again or press the Loop encoder to disengage the Loop.

► While a loop is engaged, rotate the Loop encoder to alter the Loop's size. This will pro-
duce some interesting sound variations.

Loop sizes can be changed in TRAKTOR's software preferences: Preferences>TRAK-
TOR KONTROL S8>Loop Mode Sizes>Loop.

3.3.2 Beatjumping
 

With the orange pads, you can jump forward or backward in the track by the amount prede-
fined as Beatjump size. By default, the orange pads 6 and 7 represent the Beatjump sizes of 1
beat backward and forward, whereas the beat-jump sizes of pad 5 and 8 are defined by the
Loop encoder.

To beat-jump within a track by 1 beat:

1. Press the Deck's PLAY button to start playback.
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2. Press the Deck's LOOP button to enable LOOP mode.

 
The LOOP button lights up brightly and the pads also illuminate.

3. Press pad 6 to jump back by 1 beat. If doing so causes the Playhead to cross the bounda-
ries of an active Loop area, it continues to loop again.

4. Press pad 7 to jump forward by 1 beat. If jumped out of a loop, playback continues as
normal.

Beatjump sizes can be changed in TRAKTOR's software preferences: Preferences>TRAK-
TOR KONTROL S8>Loop Mode Sizes>Beatjump.

Using the Loop encoder to define Beatjump sizes in real time

By default, pad 5 and pad 8 skip position back and forward by the amount shown in the dis-
play as loop-size value. To change this value:

1. Turn the Loop encoder to define a Beatjump size between 1/32 of a beat and 32 beats.
The Loop size will change in the display.

2. Press pad 5 to jump the playback position backward by the loop-size value displayed on
the display. If doing so causes the Playhead to jump into an active Loop area, it continues
to loop again.

3. Press pad 8 to jump the playback position forward by the beat-jump size defined in the
display. If you jump out of a loop this way, playback continues outside the loop.

3.4 Using FREEZE Mode
 

FREEZE mode takes the playhead position, adds the number of bars set as Freeze Slice Size
and splits this section of a track into eight equally sized slices. These are then mapped to the
adjacent pads, which light up blue. Press any of these pads to trigger playback from the map-
ped slice. Playback continues to the end of the track until you lift your finger off the pad.

In FREEZE mode, the numbers 1 - 8 are overlaid on the waveform to indicate the location of
the slices. The first row of pads triggers slices 1 - 4, the second row triggers slices 5 - 8
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FREEZE overlay in the display.

The pads are now lit blue, and the Freeze slices are shown on the track's waveform. The pad
that is currently illuminated brightest represents the current playback position in the Freeze
area (see the image above).

Deck A in Freeze Mode.

Prerequisites

We assume here that the S8 is in the following state:
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• The track “Techno 1” is loaded on Deck A and stopped.

• The Crossfader is all the way to the left.

• The channel fader A is raised to the top.

• The MAIN knob has an adequate level.

3.4.1 Engaging Freeze mode on a track
 

On Deck A:

1. Press PLAY to trigger playback.
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2. Press the FREEZE button.

 
The current playback position is "frozen" and a section defined by the loop size on the dis-
play is automatically split into eight slices.

3. Press any of the eight pads to trigger playback and get a feel for the slices. 

4. Press the HOTCUE button to exit Freeze mode.
If no further slice is triggered, the Playhead position will leave the frozen area and playback
continues towards the end of the track.
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3.4.2 Adjusting the Freeze Slice Size
 

1. Hold the FREEZE button.

 
The SLICE SIZE window pops up in the display.

2. While holding the FREEZE button, turn the Loop encoder to increase or decrease the slice
size from a 1/4 of a beat to a range of 4 beats.

3. Release the FREEZE button.
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→ The Slice size and zoom will change accordingly.

3.4.3 Slicer Mode
 

There's an extension of Freeze mode's functionality, called Slicer Mode. Press the Loop encod-
er while in Freeze mode and the playback behavior of the pads changes. Instead of playing
from the slice start to the end of the entire track, pressing and holding a pad in Slicer Mode
will play back just the corresponding slice repeatedly.

Slicer mode enabled.
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To enable Slicer Mode on a Deck:

1. Turn the Loop encoder to define the desired Loop size.

2. Press the Loop encoder to engage a loop.
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3. Press the FREEZE button to engage Slicer mode to the active loop.

 
The Slices appear in green.

While Slicer mode is engaged you can perform the following actions:

► Press any of the pads to jump between the Slices.
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► Hold a pad to retrigger its slice.

► Hold two pads simultaneously to loop the entire area between the first and last selected
slice.
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► Turn the Loop encoder to change the Loop size. The slice size will be changed on the fly
and the waveform in the display adjusts its zoom accordingly. 

► Press the Loop encoder or the HOTCUE button to exit Slicer mode. Playback continues as
normal.

3.5 Using FLUX Mode
 

With FLUX mode activated, for every Deck, a second Playhead continues playing along the nat-
ural progression of a track, even if you loop a section, temporarily jump back to a cue point,
skip forward or backward, etc. That way, the beat of a track keeps flowing, no matter what you
do. These are the changes in FLUX mode compared to regular operation:

• HOTCUE mode: press and hold a pad to play back from a cue point. When you let go,
playback resumes at the second Playhead's position instead of continuing from the cue
point.

• LOOP mode: when leaving a loop, playback will continue at the position of the second
Playhead instead of the loop end position

• FREEZE mode: press and hold a pad to play back from a cue point. When you let go, play-
back resumes at the second Playhead's position instead of continuing playback from the
cue point.
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Prerequisites

We assume here that the S8 is in the following state:

• The track “Techno 1” is loaded on Deck A and stopped.

• The Crossfader is all the way to the left.

• The channel fader A is raised to the top.

• The MAIN knob has an adequate level.

Enabling Flux Mode

To enable Flux mode within HOTCUE mode, LOOP mode, or FREEZE mode on Deck A:

1. Press the PLAY button to start playback.
2. Press the FLUX button to enable FLUX mode. The button lights up in orange.

3. Perform on the pads as usual. As soon as a pad is released, playback continues at the
second Playhead's position to preserve the musical phrasing.

4. Press the FLUX button again to exit FLUX mode.

Note that when the FLUX button is engaged, you cannot make use of Slicer mode on the
pads.

If the option Touch to Scratch is enabled in the TRAKTOR Preferences you can perform a
backspin effect for two beats by using FLUX mode:

1. Press the FLUX button to enable FLUX mode.
2. Hold the SHIFT button, and swipe quickly from the very right to the very left on the Touch

Strip.
3. Two beats later, release the SHIFT button.

→ The Backspin will stop and normal playback will resume right on the beat you desire.
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3.6 Remixing with Remix Decks
 

In the previous tutorials you learned how to mix using the Track Decks and how to work with
some advanced functionalities of the S8. In this tutorial, you will learn how to use the Remix
Decks. With the Remix Decks you can play and perform with pre-defined Remix Sets as well as
create your own Remix Sets by capturing samples of tracks.

Prerequisites

• Deck C is enabled.

• Channel C fader is set to minimum.

• All Remix Slot Volume Faders of the left Deck are raised.

• The EQ knobs of channel C are set to center position.

• The MAIN knob is set to an adequate output level.

• The Channel C Crossfader Assign switch is set to the left position.

• The Crossfader is all the way to the left.
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3.6.1 Loading a Remix Set
 

1. On the left Deck, press the DECK button to switch to Deck C. Remix Deck C should be
shown in the left display.

1. Press the BROWSE encoder to open the Browser.
2. Navigate to the folder TRACK COLLECTION > All Remix Sets > Remix Deck Tutorial.
3. Select the Remix Set Remix Deck Tutorial and press the BROWSE encoder to load it.
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→ The Remix set is loaded to Deck C. The display has the following appearance:

 
The pads now illuminate orange and green, corresponding to the Remix Deck page shown
in the display.

 

 

3.6.2 Triggering Samples
 

For a demonstration of how a Remix Deck works, please perform the actions listed below in the
following order:
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1. Press pad 1 to trigger its Sample Intro Beat. Playback of the Deck will start accordingly.

 
The Sample is highlighted, the Playhead of its waveform moves, and the Sample will loop.

2. Raise the channel C fader. You should now hear the Sample playing.
3. Press SHIFT + pad 1 to stop playback.
4. Now press pad 1, pad 2, pad 3, and pad 4 to trigger their samples.
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→ The first four pads light up.

 
The Samples play back.

Select another Sample of a Remix Slot

While the Samples are playing, you can switch to other Samples within the Remix Slots. For
example:
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► Press pad 5. The Sample of pad 1 Intro Beat will stop and instead the Sample of pad 5 808
Deep will start without interruption.

 

The Sample of pad 5 808 Deep is highlighted in the display.

Note that only one Sample per Remix Slot (column in the display) can play at a time.

Select other Pages of a Remix Set

A Remix Set can include up to 64 samples. On the S8 controller, the Remix Set is split into
eight pages where each set of eight samples is stored.
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To select another page of a Remix Set:

► Press Display Button 4 or 3 to scroll a page downwards or upwards.

 
Alternatively, hold the REMIX button while turning the Deck's LOOP encoder.
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3.6.3 Triggering Samples using Different Quantize Sizes
 

1. Press Display Button 2.

 
The QUANTIZE window opens in the display.
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2. Turn the Decks's BROWSE encoder to select a quantize value of 16 beats.

3. Press Display Button 2 again to close the QUANTIZE window. The quantize value is visible in
the display.

4. Now press the pads to trigger samples.

→ After you press a pad, TRAKTOR will play out the currently playing sample to the end of
the 16 beats segment and then start playing back the sample assigned to the pad you
pressed. If you selected a quantize size of 8 beats, TRAKTOR will finish the currently
playing 8 beats segment before playback of the new sample commences.
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It's a good idea to experiment with Quantize Values. Depending on the scenario, you will
often want to keep the values long (four beats, eight beats, or even longer) to keep your
musical phrases synced up. But for rapid changes between sounds, and a more "active" re-
mixing, try for values of one beat or less.

3.6.4 Adjusting Levels and using Filters of Remix Slots
 

You can adjust the output levels of the Remix Slots to balance out differences in volume or to
fade in our fade out samples smoothly:

► Move the Slot Volume faders slowly upwards or downwards to fade in or fade out samples
smoothly.

► Experiment with the FILTER and adjust channel faders to get a feeling for the mix.

3.6.5 Using the Touch Strip on a Remix Deck
 

In this brief tutorial we'll learn how the Touch Strip can be used with the Remix Deck.

On a Remix Deck which isn't playing a track:

► Swipe on the Touch Strip to move the playhead positions within the active Samples.
Swiping toward the right will move the Remix Slot playhead position in the current Remix
Deck row backward; swiping toward the left will move the Remix Slot playhead position
forward.

Just like Track Decks the Remix Decks can become out-of-phase at times, even when they
have their corresponding SYNC button engaged. The Touch Strip provides you with immedi-
ate visual feedback (via its LEDs) to allow you to make necessary adjustments.
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You cannot use the Touch Strip for seeking functions on a Remix Deck.

On a Remix Deck which isn't playing a track:

► Swipe along the Touch Strip to tempo bend.

► Hold the SHIFT button, and swipe from right to left to backspin the Samples.

► Hold the SHIFT button, and hold your finger on the Touch Strip to hold the Samples.

The SHIFT-behavior is always the same on Remix Decks regardless if the option Touch to
Scratch is disabled in TRAKTOR's Preferences.

3.7 Capturing Samples from Track Decks (Using Remix Mode)
 

You can create your own Remix Sets by capturing (or sampling) parts of a track playing back
on a Track Deck.

Note: in Remix mode, you can only capture Samples to the current Remix Set Page. Before
you start capturing select another Remix Set Page.

The Capture Source must always be a Track Deck.

Prerequisites

• The track “Techno 1” is loaded on Deck A and stopped.

• Deck C is set up as an empty Remix Deck.

• All Remix Slot Volume Faders are raised to the top.

• The Crossfader is set to center position.

• Channel faders A and C are raised to the top.

• The EQ knobs are set to center position.
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Capturing a Sample and Playback

To capture a Sample of a track on Deck A:

1. Set the focus on Deck A.
2. Hold the CAPTURE button. The LED ring around the Loop encoder starts to lit alternating

in white and blue.

3. While holding CAPTURE, touch the Loop encoder to let the CAPTURE window pop-up and
turn the Loop encoder to select the capture Source DECK A.

4. Release the Loop encoder to close the CAPTURE window and release the CAPTURE button.
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5. Press the REMIX button to enable REMIX Mode.

 
The pads should now be unlit because nothing is loaded into Remix Deck C.
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6. Press the View button to switch to Split View.

 
Both Decks A and C are shown in the display.

7. Turn the Loop encoder to define the capture size.

8. On Deck A press the PLAY button to start playback.
9. Press one of the unlit pads to capture a Sample from the current playback position.
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→ You have captured a Sample of the track.

 

The pad now illuminates a new color and the captured Sample is shown in the display.

Playback of Captured Samples from a Track Deck

As soon a Sample is captured, you can perform the following actions:
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► Capture further Samples from another Capture Source and/or using another Capture size.

 

The pads now illuminate with new colors and the first four captured samples are shown in
the display.
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► Press the illuminated pads to trigger playback. The Samples are now being mixed with
the track playing in deck A. The Samples will continue to loop within their Remix Slot.

 

Move the Slot Volume Faders above the pads to smoothly fade the Samples out or in.

► Hold the SHIFT button and press the illuminated pad to stop playing.

You can save a new Remix Set by clicking on the corresponding Deck letter in the TRAK-
TOR software and selecting Save Remix Set. Rename the set by clicking on the Deck head-
er where New Remix Set is displayed. Saved Remix Sets will be added to: BROWSER>TRACK
COLLECTION>ALL REMIXSETS.
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3.8 Adding FX
 

In this tutorial section, we will walk you through the basics of using the FX Units. By default,
TRAKTOR provides you with control over two FX Units, which can be assigned to any of the
Decks. You can set up two types of FX: Single FX and Group FX. The following sections will
explain both.

3.8.1 Assigning Decks to the FX Units
 

To assign a Deck to FX Unit 1:

► On the mixer press the left FX Assign button of a channel to assign the Deck to FX Unit
1. The FX Assign button lights up brightly.

To unassign a Deck from FX Unit 1:

► Press it again to unassign the Deck from FX Unit 1.

► On the mixer press the left FX Assign button of a channel to assign the Deck to FX Unit
2. Press it again to unassign the Deck from FX Unit 2.

All Decks can be assigned to FX Unit 1 and 2 simultaneously:
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3.8.2 Setting up an FX Unit to Group FX Mode
 

When an FX Unit is set to Group FX mode, it allows up to three different audio effects to be
used simultaneously within an FX Unit. The following section explains how to set up your own
Group FX, and how to control its three effects via the FX knobs and FX buttons.

Prerequisites

• The track "Techno 1" is loaded on Deck A. The track is playing and audible.

• All FX knobs of FX Unit 1 are set to center position.

Setting up an FX Unit to Group FX Mode

To load a Group FX into FX Unit 1:
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1. Press the FX SELECT button of FX Unit 1 at the top left of the S8.

 
The FX Unit 1 menu opens.

2. Press the FX Button 1 to display the FX Unit 1 options.
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3. Turn the BROWSE encoder to select Group, and press the BROWSE encoder to enable
Group FX mode. Three default effects are loaded into the Group FX and the FX Unit is set
up as Insert.

4. Press the FX SELECT button again to exit the FX Unit menu.

Apply the Group FX to the Track

As soon you set up your Group FX, activate the effects slots with the FX buttons and control
one parameter of each effect with the FX knobs:

The FX Knobs and FX buttons.
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► As soon you touch any FX knob, the FX panel will drop down in the display.

► Experiment with the FX Knobs 1 to 4 and listen to the resulting changes. The parameter
adjustments are also visible in the FX panel.
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► You can activate/deactivate each effect slot individually by pressing the corresponding FX
buttons 2 to 4 below.

3.8.3 Exchanging effects in the Group FX
 

To exchange any of the effects slots in a Group FX setup:

1. Press the FX SELECT button of FX Unit 1 at the top left corner of the S8 to open the FX
Unit menu.
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2. In the FX Unit menu, press FX Button 3 to exchange the effect in effects slot 2. An over-
view of available FX will be displayed.

3. Turn the BROWSE encoder to select the Gater effect and press the BROWSE encoder to
load it.
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→ You have exchanged effects slot 2 in the Group FX. Repeat this process for any of the
remaining effects in the Group FX.

 

3.8.4 Storing a Snapshot
 

You can save a default state for any of the effects by doing the following:

1. Adjust the FX knobs and buttons to your liking.
2. Press the FX button 1 to display the FX Unit's options.
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3. Turn the BROWSE encoder to select Snapshot.

4. Press the BROWSE encoder to save the Snapshot.

→ The next time you press FX Button 1 with this effect loaded, its parameters will assume
the values you stored.

3.8.5 Routing FX
 

TRAKTOR’s effects are insert effects by default, but you can also use them as post fader ef-
fects or as send effects.

► To change FX Routing, either select Insert, Post Fader, or Send in the FX Unit's options.

3.8.6 Using Four FX Units
 

TRAKTOR provides you with a total of four FX Units. By default, only the first two FX Units are
activated and can be controlled by the FX buttons and FX knobs above the display. You can
activate FX Units 3 and 4 in the TRAKTOR Preferences, which are then controlled by the Per-
formance knobs and buttons beneath the display.

Enabling the 3rd and 4th FX Unit

To activate all four FX Units:

1. Open TRAKTOR's Preferences dialog and select the Effects tab.
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2. In the FX Unit Routing section, enable 4 FX Units.

3. Close the Preferences dialog.

Assigning FX Units 3 and 4

To route a channel to FX Unit 3 or 4:

► Press the SHIFT button + the left FX assign to assign FX Unit 3 to the focused channel.

► Press the SHIFT button + the right FX assign to assign FX Unit 4 to the focused channel.

3.9 Using Performance Modes on Remix Decks
 

The S8's Remix Decks provide you with Performance Modes, allowing you to send individual
Remix Slot channels to be processed by an effect/s. The Performance Modes are available for
Remix Decks only. By default the Performance Mode Filter is applied to the Performance Con-
trols below the display.
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Prerequisites

• The Remix Set "Remix Set Tutorial" is loaded to Remix Deck C.

• FX Unit 2 is set to Single Mode and has the Reverb FX loaded.

• FX Unit 2 is assigned to Deck C.

3.9.1 Selecting and applying a Performance Mode
 

To select the FX SEND Performance Mode on Deck C:

1. Set the Deck focus to Deck C.
2. Press pads 2, 3 and 4 to trigger samples.
3. Press the left Performance Mode button until the Display reads FX SEND just above the Per-

formance controls.

4. Press the ON buttons to activate/deactivate the FX SEND per Remix Slot. Turn the Per-
formance knobs to control the mix between unprocessed and effect signals.
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You can have all Performance Modes enabled simultaneously. Skip through the Perform-
ance Modes to check which modes are active.

3.9.2 Using Performance Mode Pitch
 

When Performance Mode Pitch is enabled:

1. Touch a Performance knob to expand the PITCH parameters overview in the display.

2. Turn a Performance knob clockwise to pitch up or counterclockwise to pitch down the
samples individually.
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→ You will hear the result in the audio and see the values change in the PITCH parameters
overview.

3.9.3 Using Performance Mode Filter
 

When Performance Mode Filter is enabled:

1. Touch a Performance knob to enlarge the FILTER parameters overview in the display. 

Using Your S8—Getting Advanced

Using Performance Modes on Remix Decks

 

TRAKTOR KONTROL S8 - Manual - 137



2. Turn a Performance knob clockwise to apply hi-pass filtering to the playing Sample. Turn
a Performance knob counterclockwise to apply the low-pass filter to the playing Samples
individually.

→ You will hear the result in the audio and see the values change in the FILTER parameters
overview.

3.9.4 Using Performance Mode FX SEND
 

The Performance Mode FX SEND allows you to send signal from each Remix slot to the as-
signed FX Unit/s. In this case, Deck C is assigned to FX Unit 2, which is set up as a Reverb. As
soon as the ON Buttons are enabled in this Performance Mode, the audio effect from FX Unit
2 should become audible.

When Performance Mode FX SEND is enabled:
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1. Touch a Performance knob to expand the FX SEND parameters overview in the display.

2. Turn the Performance knobs clockwise to increase or counterclockwise to decrease the FX
SEND amount.

→ You can hear a Reverb effect being added to the Remix Slots. Slot 1's value of 25%
means that you're listening to a mix of 75% unprocessed signal and 25% Reverb.
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3.9.5 Using Performance Mode FX
 

The Performance Mode FX is only available if four FX Units are enabled in TRAKTOR's prefer-
ences as described in section ↑3.8.6, Using Four FX Units.

With the Performance Mode FX enabled:

1. Touch a Performance knob to enlarge the FX parameters overview in the display.

2. Press the ON Buttons to enable the respective FX parameters.
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3. Turn the Performance knobs to change the parameter values.

→ You will hear the result in the audio as well as see the changed values in the FX parame-
ters overview.

3.9.5.1 Changing SINGLE FX in Performance Mode
 

In the following section you will learn how to change the SINGLE FX in the FX Unit 3 or FX
Unit 4. The workflow is the same for both. This tutorial will focus on FX Unit 3.

To change the SINGLE FX in FX Unit 3:
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1. On FX Unit 1 press the FX SELECT button.

 
The FX Unit 1 menu opens.

2. On the left Deck press the ON Button 1 to switch to FX Unit 3 options. The FX Unit 3
options will open in the display.

3. Ensure the entries Single and Insert are selected.
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4. Press the FX Button 2, 3 or 4 to change the FX. This will display the FX Unit 3 menu with
available FX.

5. Turn the BROWSE encoder to select any FX and press the BROWSE encoder to assign the
FX.

 
The FX Unit 3 menu closes.
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6. Touch a Performance knob to enlarge the FX parameters overview in the display.

→ You can now see the newly assigned FX.

3.9.5.2 Changing GROUP FX in Performance Mode
 

In the following section you will learn how to change the GROUP FX in the FX Unit 3 or FX
Unit 4. The workflow is the same for both. This tutorial will focus on FX Unit 3.

To change the GROUP FX in FX Unit 3:
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1. On FX Unit 1 press the FX SELECT button.

 
The FX Unit 1 menu opens.

2. On the left Deck press the ON Button 1 to switch to FX Unit 3 options. The FX Unit 3
options will open in the display.
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3. Select the entries Group and Insert.

4. Press the FX Button 2, 3 or 4 where you want to change the FX. This will display the FX
Unit 3 menu with available FX.

5. Turn the BROWSE encoder to select an FX, and press the BROWSE encoder to load it.
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→ You have changed the FX in the Group FX.

3.10 Mixing Stem Files using Stem Decks
 

In this tutorial you will learn how to load and play back a Stem File, and how to perform on
Stem Decks.

Stem Files allow you to interact with four different musical elements of a track independently
while DJing. The four stems of a track can be modified individually to create spontaneous in-
strumentals, remixes, or mashups. You can create transitions between elements stem-by-stem,
or apply effects and EQ to just to a specific stem instead of the entire track. To get really crea-
tive, try swapping elements across multiple Stem Decks, for example, you could take the vo-
cals from one track and mix it with the beat from another. Utilizing yourS8, in combination
with TRAKTOR, you can mix music at a deeper level.

Stem Files

A Stem File is a track in the file format .stem.mp4 that contains four audio tracks (Stem
Parts). Each Stem Part represents one of the key elements e.g. drums, percussions, synths, vo-
cals, of the entire track. By default when a Stem File is played back in TRAKTOR all Stem
Parts are audible and result in an entire track.
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Due to the large amount of data that must be read from a Stem File, it is currently neces-
sary that Stem Files are analyzed before loading into a Stem Deck. It is not possible to load
and play a Stem File before it has been analyzed. For more information on how to analyze
tracks or Stem Files, refer to the TRAKTOR Manual.

The Stem Deck

On the display of the TRAKTOR KONTROL S8 the Stem Deck looks identical to a conventional
Track Deck but showing the additional identifier STEM. Furthermore, the titles of the Stem Parts
are visible in the Performance mode pane.

The Stem Deck on the S8.

3.10.1 Loading and Playing a Stem File
 

Prerequisites

We assume here you already have imported and analyzed your Stem Files in your Track Collec-
tion and your TRAKTOR KONTROL S8 is in the following state:

• Decks A and B are focused and stopped.

• The channel faders A and B are set to the maximum level.

• The Crossfader is set to center position.

• On the left Deck all Slot Volume faders are set to the maximum level.
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• On the right Deck all Slot Volume faders are set to the minimum level.

Loading a Stem File

To load a Stem File into the left Deck A:

1. Press the BROWSE encoder to open the Browser.
2. Turn the BROWSE encoder to navigate to TRACK COLLECTION > All Stems >.

3. Select a Stem File.
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1. Press the BROWSE encoder again to load the Stem File. The Deck Flavor automatically
switches to Stem Deck.

► Press the PLAY button to start playback.

→ The Stem File is playing back and the waveform is moving in the display.

3.10.2 Switching between Track View and Stem View
 

To have an individual view of the Stem Parts waveforms switch the view in the display from
Track View to Stem View.

In Track View the display shows the waveform of the entire Stem File.
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Stem Deck in Track View.

In Stem View the display shows the four colored waveforms of the Stem Parts.

Stem Deck in Stem View.

To switch the view:

1. Hold the SHIFT button. Depending on current view either Display Button 3 or 4 will light
up.
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2. Press the unlit Display button to switch the view in the display.

3.10.3 Performing with Stem Decks
 

While the Stem File is playing back you can perform the following actions on the Stem Deck:

Adjusting or Cutting Volumes of Stem Parts

To adjust the volumes of key elements from the music or to take them out completely:

► Move the four Slot Volume Faders downwards or upwards.

→ You will hear the Stem Parts change in volume or they will be completely taken out of the
mix.

Applying FILTER to Stem Parts

To apply the FILTER to Stem Parts:
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1. Press the Performance Mode buttons until the FILTER page is selected in the Performance
Mode pane.

2. Press the ON buttons to activate the filter.
3. Turn the respective Performance knob to change the parameters for applying a high-pass

or a low-pass filter.

Applying FX SEND to Stem Parts

You can also apply FX SEND to any of the Stem Parts.

To apply the FX Unit’s FX to Stem Parts:
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1. On channel A press the right FX Assign button to assign the Stem Deck to FX Unit 2.
2. Press the Performance Mode buttons until the FX SEND page is selected in the Performance

Mode pane.

3. Press the ON buttons to apply the FX of the FX Unit 2 to the Stem Parts.
4. Turn the Performance knobs clockwise to increase or counterclockwise to decrease the FX

SEND amount.
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Additional Information about Performing with Stem Decks

Besides the aforementioned actions for performing on Stem Decks you can also make use of
setting Hotcues, applying Loops, using FREEZE mode, using FLUX mode, and using the Touch
Strip as you learned in previous tutorials.

It is not possible to capture Samples from Stem Files.

3.10.4 Adding another Stem File to the Mix
 

Equipped with the fundamental knowledge about performing on a Stem Deck you will now
learn to mix Stem File on Deck A into another Stem File on Deck B.

3.10.4.1 Loading a Stem File into Deck B
 

We assume here you are using a second TRAKTOR KONTROL S8 controller.

To load a Stem File into the right Deck B:

1. Press the BROWSE encoder to open the Browser.
2. Turn the BROWSE encoder to navigate to TRACK COLLECTION > All Stems >.
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3. Select a Stem File.

4. Press the BROWSE encoder to load the Stem File. The Deck Flavor automatically switches
to Stem Deck and is set to SYNC.

5. Press the PLAY button to start playback.

→ The Stem File is playing back on Deck B and in sync with the Stem File on Deck A.

After all Slot Volume Faders are set to minimum position, you should not hear any audio from
the Stem File of Deck B.
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3.10.4.2 Combining Sounds of different Stem Decks
 

While the Stem Files are playing back on Deck A and Deck B, you can now perform the follow-
ing actions for mixing both Stem Files. We assume here that the Stem Parts of both of your
chosen Stem Files are using the same naming and coloring scheme e.g. Stem Part 1 for
drums, Stem Part 2 for bass, Stem Part 3 for melody, and Stem Part 4 for vocals.

Combining Sounds

To combine the Sounds of the Stem File on Deck A with the Sounds of the Stem File on Deck
B:

1. On the right Deck move the Slot Volume Faders to the maximum position one by one. The
Stem Parts of both Stem Files are now audible in the mix.

2. Lower and raise the Slot Volume Faders of both Stem Decks to combine the sounds of
both Stem Files.

3. On the left Deck move the Slot Volume Faders to the minimum position. You now hear the
sounds of Stem File on Deck B only.

3.11 Working with Beatgrids
 

TRAKTOR recognizes a track's BPM precisely and sets the Beatgrid. Some tracks, however,
need manual correction e.g. a track with a complex rhythm or with uneven timing, coming from
a tape machine or warped vinyl, and the S8 provides you with the controls to do this.

3.11.1 Checking a Beatgrid
 

To guarantee that all Tempo, Loop and Move controls work as expected, you will have to verify
the Beatgrid for your tracks:
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1. Load a track into a Track Deck. The Track will be analyzed.

2. Press Display Button 3 to zoom into the waveform and get a more precise view.

3. Check the Beatmarker at the beginning of the track.
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→ In this example, you can see the Beatmarker isn't aligned with the very beginning of the
waveform. As a result, the track will not sync with others. 

In the following section you will learn how to fix a misaligned Beatgrid manually.

3.11.2 Correcting a Beatgrid Manually
 

If it a track is not correctly aligned to the beat, use Beatgrid mode to fix it. The following sec-
tion will explain the required steps.

Enabling the Beatgrid Mode

To enable the Beatgrid mode:
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1. Press the EDIT button.

 
The Beatgrid mode opens in the display. A four beat loop at the current playback position
is displayed.

2. Press the Deck's PLAY button to trigger playback of the track.
On the display, you'll see a four beat loop, based on the detected BPM value, which serves as a
reference for manual Beatgrid adjustments. While playing back the track, a white position
pointer cycles through, indicating the relative sync position within the loop. In the background,
the entire track is played back and the red playhead travels across the waveform displayed be-
low the loop.

Beatgrid Interactions

While the track is playing with Beatgrid Mode enabled:

► Rotate Performance knob 1 (OFFSET) to shift the entire waveform underneath the Beatgrid.
Align the first Beatmarker with the first peak in the loop's waveform.
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► Rotate Performance knob 2 (BPM) to correct the detected BPM value in coarse steps. Try
to align the second, third and fourth beat (in most cases indicated by the biggest peaks
in the waveform) with the second, third and fourth Beatmarker.

► Rotate Performance knob 3 (FINE) to fine-adjust the BPM value.

► Press SHIFT and turn Performance knob 2 (BPM) to double or halve the current BPM val-
ue.
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► Rotate Performance knob 4 (SCAN) to scroll through the track. Check if the Beatgrid stays
aligned over the course of the track.

Position-aware Beatgrid Tempo Adjustment

Performance knobs 3 and 4 (BPM) are scaled based on the viewing position of Beatgrid mode
so that adjustments made far away from the Beatmarker don’t result in abrupt changes to the
waveform position. For example, if you are near the Beatmarker at the start of a track and
change the tempo of the Beatgrid, you will see the waveform move under the Beatgrid by a
particular amount. If you then scan later into the track, adjusting the tempo will create a simi-
lar amount of motion on the waveform (rather than a large amount of motion) thus allowing for
precise setting of the Beatgrid tempo over the length of the track.

Beatgrid Zoom Mode

To set the position of the Beatgrid with greater precision you can use the Beatgrid Zoom mode:

1. Press the ON button 1 to zoom in the first beat.

2. Rotate Performance knob 3 and 4 to adjust the Beatgrid.
3. Press the ON button 1 again to exit Beatgrid Zoom mode.
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3.11.3 Additional Help Actions
 

Tap the Tempo

Tap allows you to manually set the tempo by tapping along the playing track:

► Press Display Button 3 (TAP) four times in sync with the playback.

→ The tempo is calculated and the Beatgrid adapts to the tempo.

Tick (Audible Beatgrid)

The Tick works like a metronome, giving you an audible pulse for every beat. Align the Tick
and the beats in your track for perfect sync.

You can only hear the Tick on the CUE (headphones), not the MAIN (audience).
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► Press Display Button 2 to enable Tick.

→ The beat tick will then be audible in your headphones when cued.

Reset your edits

If your edits do not produce the desired result, you can undo your edits:

► Press Display Button 4 (RST).

→ This will reset your edits to the auto-detected values.
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Lock the Beatgrid

Once the Beatgrid is correctly aligned with the beat throughout the whole track:

► Press Display Button 1 (LOCK).

→ All buttons in the Beatgrid panel are deactivated.

The stored tempo (BPM) is locked and cannot be changed until you unlock it by clicking LOCK
again. All tracks with a locked Beatgrid will show a small Lock Icon within the Browser.
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4 Hardware Reference

 

This chapter details the interface elements on your S8 and explains how they interact with the
TRAKTOR software. This includes an overview of the main areas of the user interface, as well
as a full reference for every button, knob, fader, and the color displays.

4.1 Overview of the Controller
 

This section provides you with an overview of the different areas of the controller's interface.

Sections on S8's Top side
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The top panel of the TRAKTOR KONTROL S8 is divided into three main areas listed in the ta-
ble below: The table also provides the links referring to the section with more information.

Callout Description Link to section providing further information

(1) Decks ↑4.2, The Deck

(2) FX Units ↑4.3, The FX Unit

(3) Mixer ↑4.4, The Mixer

 

4.2 The Deck
 

This chapter provides a detailed description of how the knobs, buttons and faders in S8's Deck
section relate to the TRAKTOR workflow.

Since the left and right Decks work identically, we'll just talk about the left one. Implicitly,
though, the descriptions also apply to the right Deck.

S8 features two identically equipped Deck sections at the far left and right sides of the unit.
These give you hardware control over the software Decks in the TRAKTOR PRO software. Active
TRAKTOR Decks always work in one of the Deck modes, as either Track Deck, Remix Deck or
Live Input.

If you connect an external device to S8, you can also bypass the Deck completely by
switching the corresponding Mixer channel from TRAKTOR mode to Thru mode. This will
automatically de-activate the Deck.

For more details about the Deck modes, please refer to the TRAKTOR Manual.

The left-hand hardware Deck controls TRAKTOR's Decks A and C. The entire section can be
focused on either the primary (A) or secondary (C) Deck. The positions of Decks on S8 are con-
sistent with the Deck layout in TRAKTOR PRO:

• The left-hand Deck controls TRAKTOR Decks A (on top) and C (below).

• The right-hand Deck controls TRAKTOR Decks B (on top) and D (below).

The following image and table give a detailed overview of the Deck's elements and links refer-
ring to sections with further information.
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Interface elements on the Left Deck

Callout Description Link to section providing further information

(1) DECK button ↑4.2.1, DECK Button

(2) FLUX button ↑4.2.2, FLUX Button

(3) Mode Select buttons ↑4.2.3, Mode Select Buttons

(4) Loop Encoder ↑4.2.4, Loop Encoder

(5) EDIT button ↑4.2.5, EDIT Button
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Callout Description Link to section providing further information

(6) CAPTURE button ↑4.2.6, CAPTURE Button

(7) Display and BROWSE controls ↑4.2.7, Display Area and Controls

(8) Performance controls ↑4.2.8, Performance Controls

(9) Slot Volume faders ↑4.2.9, Slot Volume Faders

(10) Pads ↑4.2.10, Pads

(11) Touch Strip ↑4.2.11, Touch Strip

(12) TRANSPORT controls ↑4.2.12, Transport Controls

4.2.1 DECK Button
 

The DECK Button allows you to switch the focus (and controls) between the primary and sec-
ondary Decks in a Deck section.

DECK Button

The DECK button lights blue when a primary Deck (A or B) is focused and white when the sec-
ondary Deck (C or D) is focused.

4.2.2 FLUX Button
 

Press S8's FLUX button to enable Flux Mode for the focused Deck.

FLUX Button
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In Flux mode, for every Deck, a second playhead continues playing the track, even if you loop a
section, temporarily jump back to a cue point, skip forward or backward, etc. That way, the
track keeps progressing, no matter what you do.

4.2.3 Mode Select Buttons
 

Below the Slot Volume Faders, S8 features 8 pads per Deck which function either as Remix
Pads, as loop marker triggers or as cue marker triggers, depending on which of the four modes
you select via the Mode Select buttons:

Mode Select Buttons

General Behavior of Mode Select Buttons:

• The default mode for a Track Deck is Hotcue.

• The default mode for a Remix Deck is Remix.

• Remix mode is exclusive to Remix Decks.

• Hotcue isn't available for Remix Decks.

4.2.3.1 HOTCUE Button
 

Hotcue is the default mode for Track Decks. While in Hotcue mode, the pads store and trigger
CUE markers in a track while it's playing. This mode is disabled automatically when you switch
focus to a Remix Deck.
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HOTCUE Button

4.2.3.2 LOOP Button
 

The LOOP button activates LOOP mode.

LOOP Button

When Loop mode is activated, the first row of pads turns green, and the second row turns or-
ange.

Pads in Loop Mode

Looping

• The first row of pads (green) allow you to loop a part of a track. By default the pads are
assigned common loop sizes1/8 of a beat, 1/4 of a beat, 1/2 of a beat, 1 beat.

You can change the loop sizes in TRAKTOR's S8 Preferences:
Preferences>Traktor Kontrol S8>Loop Mode Sizes > Loop
For more information, see the TRAKTOR manual.
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• If Quantize is activated, TRAKTOR will loop from the next beat.

• If Quantize is deactivated, looping starts immediately when you press the pad.

The behavior of the pads changes when you activate FLUX mode. While FLUX is deactivat-
ed, the loop will play back until you press that pad again. With FLUX activated, looping
stops as soon as you release the pad.

Beatjump

The second row of pads (orange) allow you to jump backward and forward in a track in prede-
fined steps, in sync with the track's tempo. By default, the step sizes are:

• Jump back 1 loop size (set per Deck).

• Jump back 1 beat.

• Jump forward 1 beat.

• Jump forward 1 loop size (set per Deck).

Beatjump sizes can be changed in TRAKTOR's software preferences: Preferences>TRAK-
TOR KONTROL S8>Loop Mode Sizes>Beatjump.

• If Quantize is activated, TRAKTOR waits for the next beat before jumping.

• If Quantize is deactivated, TRAKTOR jumps immediately after pressing the pad.

4.2.3.3 FREEZE Button
 

The FREEZE button enables the Freeze mode.

FREEZE Button

Freeze Mode

Freeze mode takes the playhead position, adds the number of bars set as loop size and splits
this section of a track into eight equally sized slices. These are then mapped to the adjacent
pads, which light up blue. Press any of these pads to trigger playback from the mapped slice.
Playback continues to the end of the track until you release the pad.
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In Freeze mode, the numbers 1 - 8 are overlaid on the waveform to indicate the location of the
slices. The first row triggers slices 1 - 4, the second row triggers slices 5 - 8.

Freeze Mode Overlay

► Adjust the size of the Freeze slices by pressing and holding the FREEZE button and then
turning the Loop encoder. The waveform in the display adjusts its zoom level accordingly.

You can vary slice sizes between 1/4 beat and 4 beats.
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Slicer Mode

The Slicer Mode extends the Freeze mode's functionality. Press the LOOP button while in
Freeze mode and the playback behavior of the pads changes: Instead of playing from the slice
start to the end of the entire track, pressing and holding a pad in Slicer Mode will play back
just the corresponding slice in a loop.

In Slicer Mode, the pads turn green and while playing back the selected loop, pads flash
bright green while the assigned slice is played back. This is also reflected on the Deck's
display.

4.2.3.4 REMIX Button
 

Remix mode allows you to capture portions of a track from the capture source and assign them
to one of the pads.

REMIX Button

Remix mode is the default for Remix Decks, and isn't available for Track Decks. If a Track
Deck is in focus, the REMIX button is deactivated for that Deck.

If the Deck you set as capture source is empty, S8's display shows Error while copying in the
Deck header.

For more detailed information on capturing samples, refer to section ↑4.2.6, CAPTURE Button.

4.2.4 Loop Encoder
 

The Loop encoder is dedicated to looping functions on either Track Decks or Remix Decks. It
has a press function to engage a loop, a rotate function to adjust the loop size, as well as a
segmented LED ring indicating that a loop is engaged.
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Loop Encoder

You cannot permanently engage a loop when the FLUX button is active. The loop only re-
mains active for as long as you hold the Loop encoder and turns off again when released.
Adjustments to loop size can be made whether a loop is active or not.

Moving the Playhead

When a loop is inactive, the Loop encoder can also be used for moving the playhead in incre-
ments of the Loop size by holding SHIFT and then turning the loop encoder.

4.2.5 EDIT Button
 

Pressing the EDIT button lets you adjust a track's Beatgrid. The TRAKTOR software can analyze
your music and apply a Beat Grid which allows automatic beat-matching and synchronization.

EDIT Button

In most cases (through its Analyze function), TRAKTOR recognizes a track's BPM precisely and
sets the Beat Grid. Some tracks, however, need manual correction (e.g. a track with a complex
rhythm or with uneven timing, coming from a tape machine or warped LP), and the S8 pro-
vides you with the controls to do this. Please read chapter ↑3.11, Working with Beatgrids for
more information.

The EDIT button is disabled when a Remix Deck is focused. Beatgrid editing only applies
to Track Decks.
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4.2.6 CAPTURE Button
 

Pressing the CAPTURE button allows you to quickly select the capture source for a Remix
Deck.

CAPTURE Button

The capture Source can be selected by holding the CAPTURE button and turning the BROWSE
encoder. Pressing a pad will then sample content from the Deck set as Capture source to the
corresponding Remix Cell.

The capture size is determined by the source Deck's loop size setting.

4.2.7 Display Area and Controls
 

On the S8's graphic color displays, some functionality is dynamically shown or hidden by
means of the Display buttons adjacent to the display. The following image and table give a de-
tailed overview of the Display area and controls and provide links referring to sections with fur-
ther information.

Hardware Reference

The Deck

 

TRAKTOR KONTROL S8 - Manual - 176



Display Area and Controls

Callout Description Links leading to section with further information

(1) BACK Button ↑4.2.7.1, BACK Button

(2) BROWSE Encoder ↑4.2.7.2, BROWSE Encoder

(3) Settings Button ↑4.2.7.3, Settings Button

(4) Display Buttons ↑4.2.7.4, Display Buttons

(5) Display ↑4.2.7.5, Display

(6) View Button ↑4.2.7.6, View Button

(7) Performance Mode Buttons ↑4.2.7.7, Performance Mode Button
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4.2.7.1 BACK Button
 

When the Browser is opened, pressing the BACK button lets you navigate a level up in the fold-
er structure, up to the Browser's top level. Pressing the BACK button for longer than a second
lets you exit the Browser.

BACK Button

4.2.7.2 BROWSE Encoder
 

The BROWSE encoder lets you access the Browser and navigate through your track collection
and playlists.

BROWSE Encoder and BACK Button

• Pressing the BROWSE encoder lets you open the Browser in the display.

• Turning the BROWSE encoder lets you scroll through the list items. Pressing it again en-
ters a sub folder and again loads an item.

Besides browsing, you can use the BROWSE encoder to adjust the BPM and KEY parameters
in the respective pop-ups and to select effects in the FX Unit configuration screen.

You can configure the Browse encoder to open the Browser on touch. To do so, activate the
Auto Open Browser on Touch option in TRAKTOR's TRAKTOR KONTROL S8 Preferences.

4.2.7.3 Settings Button
 

The Settings button is on the top-left.
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Settings Button

► Press this button to open S8's device settings.

Display Settings (RGB)

Within the settings, you can adjust the screens' color rendition (saturation of RED, GREEN and
BLUE colors), as well as the screen's BRIGHTNESS.

► Turn the Performance knobs beneath the display to adjust the parameters.

Display Settings View

Touch Sensitivity Settings (TOUCH)

1. When in the Settings, press Display Button 2 twice to switch to the TOUCH settings.
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2. Turn the Performance knobs underneath the display to increase or decrease global touch
sensitivity for different kinds of controls: ENCODERS, ENDLESS KNOBS, KNOBS, and FADERS.

Touch Settings View

4.2.7.4 Display Buttons
 

These buttons provide different functionality depending on the view you're working in.
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Display Buttons

 

Press any of these buttons to open the pop-up and see each button's functionality

This is an overview of what these buttons do depending on what you see on the display.

Track Deck View

(1) Display Button 1: Opens the BPM pop-up.

(2) Display Button 2: Opens the KEY window.

(3) Display Button 3: Zooms into the waveform.

(4) Display Button 4: Zooms out of the waveform.

Remix Deck View

(1) Display Button 1: Opens the BPM pop-up.

(2) Display Button 2: Opens the QUANTIZE pop-up.

(3) Display Button 3: Scrolls up in the Sample Grid in steps of two.

(4) Display Button 4: Scrolls down in the Sample Grid in steps of two.
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Please note that you can leave any pop-up by pressing the same button again or, alterna-
tively, the View button.

4.2.7.5 Display
 

TRAKTOR PRO's default layout is 2 Track + 2 Remix Decks (Scratch). This means that S8's
two upper Decks (A and B) are Track Decks, and the lower Decks (C and D) Remix Decks.

• The left display provides feedback about Decks A and C.

• The right display provides feedback about Decks B and D.

Every active TRAKTOR Deck is either a Track Deck, Remix Deck or Live Input Deck. If a mixer
channel is set to Thru mode on S8, the corresponding TRAKTOR Deck is set to Thru mode, as
well. Here's an overview of the information S8's displays provide for each of these:
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Track Deck

Track Deck View
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Track Deck View

A Track Deck view on S8 provides information about:

(1) Artwork, Song title and Artist name.

(2) Loop size: From 1/32 - 32 beats.

(3) Playhead position: time played and time remaining.

(4) Deck tempo in BPM.

(5) Deck Focus: Deck A - D.

(6) Sync state: If a Deck is assigned Tempo Master, MASTER is displayed underneath the BPM
value. SYNC indicates that the Deck is synchronized to a Tempo Master. If a Deck isn't
synchronized at all, the Deck header shows tempo deviation in percent from the file's original
tempo.
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Remix Deck

Remix Deck View
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Remix Deck View

A Remix Deck view on S8 provides information about:

(1) Artwork graphic, Set title and Artist name.

(2) Loop size: from 1/32 - 32 beats.

(3) Quantize Value.

(4) Deck tempo in BPM.

(5) Deck Focus: Deck A - D.

(6) Sync state: If a Deck is assigned Tempo Master, MASTER is displayed underneath the BPM
value. SYNC indicates that the Deck is synchronized to a Tempo Master. If a Deck isn't
synchronized at all, the Deck header shows tempo deviation in percent from the file's original
tempo.
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(7) The absolute position on TRAKTOR's timeline measured in Bars.Beats.Phrases.

Live Input Deck

S8's rear panel allows you to connect microphones, turntables, or CD players. You can route
these audio signals into the TRAKTOR software and mix them with your other Decks by setting
a Deck to Live Input mode. In this mode, S8's display reads Live Input - Traktor Audio Passthru.

S8's Transport Controls are disabled while a Deck runs as Live Input.

Thru Mode

If you don't need to run an external device like turntable or CD player through a Deck, switch
that mixer channel to Thru mode on S8 by pressing the TRAKTOR button. The signal is mixed
in S8's mixer and never sent to TRAKTOR then.

4.2.7.6 View Button
 

The View button is located in the top right corner of the display area.

View Button

It switches between view types:

• Single View: Only the focused Deck is displayed.

• Split View: Both Decks are displayed; the focused Deck is visualized by a big waveform
and detailed information, while the unfocused Deck is reduced to a small waveform,
showing markers and a playhead.

Whenever you open a pop-up from a Deck view (e.g. FX Selection Menu, Browser, BPM, or
KEY), the View button starts flashing. Press the View button to close the pop-up.

4.2.7.7 Performance Mode Button
 

The Performance Mode buttons are at the bottom on either side of the display, marked with
left and right arrows.
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Left Performance Mode Button

► To cycle through the parameters you can control with the Performance Controls (FILTER,
PITCH, FX SEND), press one of the buttons repeatedly.

If you activate 4 FX Units in TRAKTOR's preferences, the Performance Mode buttons allow
you to select FX Units 3 and 4 as a fourth option.

4.2.8 Performance Controls
 

Underneath the display, the Deck features four encoders and buttons which control either FIL-
TER, PITCH or FX SEND per Slot in a Remix Deck, depending on the selected Performance mode.

Performance Controls

Performance Mode FILTER

The default Performance Mode for a Remix Deck is FILTER. The Performance ON buttons are
used to engage/disengage a Remix Slot's FILTER. The FILTER cutoff is controlled by the corre-
sponding Performance knob. Adjustments to FILTER cutoff are shown via the Performance pop-
up at the lower end of the displays.

The Performance Controls work even if the Remix Deck isn't focused.

If you set up TRAKTOR with 4 FX Units, the Performance knobs and buttons in Deck A
control FX Unit 3, those in Deck B control FX Unit 4. By default, they have no function for
Track Decks.
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FX SEND

When FX SEND is selected, the knobs control the amount of signal being sent to the assigned FX
Unit(s), per Slot. The FX SEND amount is displayed right above the corresponding knob.

In case you increase FX SEND and still don't hear any effect, please make sure the Remix
Deck is actually assigned to an FX Unit in the corresponding Mixer channel.

For information on using the Performance Controls to operate FX Units (3 and 4), refer to
section ↑4.3.3, Additional FX Unit 3 and 4.

PITCH

When PITCH is selected, the Performance knobs transpose the pitch of the currently playing
sample. In other words: pitch correction is applied per Remix Cell. The amount of pitch change
is displayed above the corresponding knob.

4.2.9 Slot Volume Faders
 

S8 offers a separate volume fader per slot. This allows you to mix signals from up to four slots
within a single Remix Deck, before it runs through the channel fader and the Crossfader.

• In case only one Deck per side is a Remix Deck, the faders control that Remix Deck's slot
volume even if another Deck is focused.

• In case both the primary and secondary Deck are configured as Remix Decks, the Slot
Volume faders control the focused Deck's slots.

Slot Volume Faders
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4.2.10 Pads
 

Each of S8's Decks comes with a set of 8 pads. Depending on the mode selected via the Mode
Select buttons, these pads are assigned different functions.

Pads

Here's an overview of what the pads do in each mode:

HOTCUE mode

During playback, pressing in an inactive pad sets a cue point. The pad lights up and the cue
point is automatically assigned to this pad. Pressing that pad again let jump back the playhead
to the cue point just defined.

LOOP mode

In Loop mode, pressing a pad instantly loops playback for the number of bars set as Loop
Mode Size in Preferences > Traktor Kontrol S8 > Loop Mode Sizes > Loop. These values are by
default:

• 1/8 Bar Loop

• 1/4 Bar Loop

• 1/2 Bar Loop

• 1 Bar Loop
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The Loop functionality considers the global Quantize setting:

• If Quantize is active, TRAKTOR delays starting the loop until the next down-beat, making
sure looping keeps the track in sync.

• If Quantize is deactivated, looping starts precisely when you press the pad.

FREEZE and Slicer Mode

In Freeze mode, TRAKTOR takes the playhead position, adds the number of bars set as loop
size and splits this section of a track into eight equally sized slices. These are then mapped to
the pads. Press a pad to start playback from that slice.

While in Freeze mode, you can access Slicer mode. This is how Slicer mode is different from
Freeze mode:

• In Slicer mode, holding a pad will infinitely loop the corresponding slice.

• In Slicer mode, holding two pads will loop the range between the start of one pad and the
end of the second.

By pressing the Loop encoder while Freeze mode is active this will enable the Slicer mode. The
slices in the display and pad color change from blue to green.

REMIX Mode

In Remix mode, the pads trigger the content of corresponding Remix Cells - the tracks, loops
or Samples defined in the Remix Set. After loading a Remix Set, the pads take on the Sample
Cells' color. By pressing Display buttons 3 and 4 you can scroll through the rows of Remix
Cells in steps of two.

4.2.11 Touch Strip
 

S8 doesn't feature the conventional Jog Wheels of a regular DJ controller. Functions usually
associated with Jog Wheels are instead controlled by the intuitive Touch Strips.

The Touch Strip
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Utilizing the Touch Strip, you can:

• Seek/navigate within the track.

• Tempo bend (nudge) for aligning beats.

• Create a scratch effect

• Holding the track or Samples.

• Backspinning the track or the Samples.

Above the Touch Strip, a number of LEDs provide visual feedback for the actions taken on the
touch strip.

Phase Meter

For Track- and Remix Decks, the LEDs work as a Beat Phase Meter, showing the focused Deck's
beat phase offset from the MASTER Deck. This is the same meter as displayed in TRAKTOR's
Deck.

Direction of Scratching

If you didn't learn scratching with LPs and turntables, you may find inversing the Touch Strip's
direction more intuitive. If you select this option, swiping to the right on the Touch Strip will
move forward in the track's waveform.

► Inverse the directional response by unchecking the Invert checkbox in TRAKTOR's S8
preferences: Preferences> Traktor Kontrol S8>Touchstrip>Scratch Sensitivity.

For detailed information on the Touch Strip's preferences, refer to section ↑6.3, Touchstrip.

Direction of Tempo Bending

In TRAKTOR's default setting, swiping your finger on the Touch Strip has a similar effect to
speeding up or slowing down an LP with your hand:

• Move to the left to speed up the LP.

• Move to the right to slow down the LP.

Hardware Reference

The Deck

 

TRAKTOR KONTROL S8 - Manual - 192



If you didn't learn aligning Decks on turntables, this behavior may not make sense to you. In-
stead, looking at the waveform, you think in terms of moving the playhead position within the
track. Also, you want Tempo Bending to be consistent with Seeking:

• Swipe to the right to move the playhead ahead

• Swipe to the left to move the playhead back.

Inversed Tempo Bending Direction

To achieve this, uncheck the Invert option in: Preferences> Traktor Kontrol S8>Touch-
strip>Bend Sensitivity.

Sensitivity

S8 comes with a Sensitivity setting which should accommodate most users in most situations.
You might, however, find that the touch strip doesn't react immediate enough to your input or
just the opposite, it may recognize input where there was none intended.

You can adjust the Touchstrip's Bend Sensitivity and Scratch Sensitivity separately in: Prefer-
ences> Traktor Kontrol S8>Touchstrip.
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4.2.12 Transport Controls
 

The Transport buttons control playback of S8's Decks.

These controls only relate to TRAKTOR mode, they have no function when the S8 is used
as a stand-alone device.

PLAY Button

The PLAY button starts/stops the playback of a Deck.

PLAY Button

CUE Button

The CUE button is tied to the Cue Points workflow in TRAKTOR.

CUE Button

The CUE button functions as follows:

• If a Deck is playing, press CUE to jump to the Floating Cue Point and stop playback.

• If a Deck is paused, press CUE to set a new Floating Cue Point (which replaces the previ-
ous one).

• Press CUE + PLAY and the Deck will keep playing after releasing the buttons.

• Press SHIFT + CUE to skip back to the beginning of the track.

SYNC Button

The SYNC button activates/deactivates the synchronization of the currently focused Deck to
the Tempo Master (i.e. the Deck set as the MASTER or TRAKTOR's Master Clock).
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SYNC Button when in Sync

► While playing, press SHIFT + SYNC to set a Deck as the Tempo Master.

→ The Deck's tempo becomes the tempo reference for all other synced Decks and FX. S8's
display shows MASTER in the Deck header of the Master Deck.

The SYNC button takes on different states to provide visual feedback:

• If the Deck is BPM-synced and in phase with the Tempo Master, the button is bright
green.

• If the Deck is BPM-synced but out of phase with the Tempo Master, the button is bright
red.

• If the Deck is unsynced, the button is dim green.

If a focused Deck gets out of phase, you can compensate by:

► Swiping your finger across the corresponding Touch Strip to re-align the beat phase.

► Pressing the SYNC button twice to snap back into sync with the Tempo Master.

SHIFT Button

The SHIFT button is a modifier for other control elements on the S8. It allows you to access
secondary functions, just like the [Ctrl] ([Cmd] on Mac OS X) key on your computer keyboard
does.

SHIFT Button

► To access a button's or knob's secondary function, hold SHIFT and then use that control
element.
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• For the control elements in S8's Deck section, SHIFT operates locally i.e. you cannot use
the left SHIFT to access the secondary functions of a Deck or FX Unit on the right side of
the controller.

• For S8's Mixer section, either SHIFT button can be used to access the secondary func-
tions.

You will find examples of using the SHIFT button to access secondary functions throughout
this document.

4.3 The FX Unit
 

Above the Decks, the S8 features two FX Units which can be assigned to any of the Decks.
Four knobs and buttons per FX Unit allow you to control effects parameters in real time.

FX Units 1 and 2

S8 comes with dedicated controls for TRAKTOR's two FX Units. Just like in the software, FX
Unit 1 is located in the top-left corner, FX Unit 2 in the top-right.

FX Units allow you to creatively process a track, ranging anywhere from just adding reverb for a
build-up to completely messing up a beat with stutter effects. For that purpose, the TRAKTOR
software offers a great selection of high-quality FX. These can easily be configured from S8
and be controlled utilizing the FX Unit controls.
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The Left FX Unit

By default, FX Units 1 and 2 are always active. Assign effects to any mixer channel via the
respective channel's FX Assign buttons. Left assigns to FX1, right to FX 2.

This is an overview of the naming and function of the FX Unit's key control elements. The
knobs in this section are sensitive to touch. Touch any of them to open the FX drop-down
menu that provides an overview of the effect(s) loaded along with control assignments and pa-
rameter values.

• Single Mode: select one effect; the FX knobs let you control up to 4 parameters.

• Group Mode: select up to three effects as an effects chain; the FX knobs let you control
one parameter per effect.

The following table gives a detailed overview of the parameters controlled by FX buttons and
FX knobs and it provides links referring to sections with further information.

Name Function in Single Mode Function in Group mode

FX Button 1 Activate/deactivate the entire FX Unit. -

FX Button 2 Reset all FX parameters to their de-
fault value.

Activate/deactivate FX slot 1.

FX Button 3 Depends on the selected effect. Activate/deactivate FX slot 2.

FX Button 4 Depends on the selected effect. Activate/deactivate FX slot 3.

FX Knob 1 Adjust the ratio between the unpro-
cessed (dry) signal and processed
(wet) signal for the entire FX Unit.

Adjust the ratio between the unpro-
cessed (dry) signal and processed
(wet) signal for the entire FX Unit.

FX Knob 2 Controls FX parameter 1. Control the 1st effect in the FX Unit.
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Name Function in Single Mode Function in Group mode

FX Knob 3 Controls FX parameter 2. Control the 2nd effect in the FX Unit.

FX Knob 4 Controls FX parameter 3. Control the 3rd effect in the FX Unit.

FX Unit 2 has the same layout as FX Unit 1, apart from the FX SECTION button being lo-
cated in the top-right corner of the device.

 

4.3.1 FX SELECT Button
 

Pressing the FX SELECT button let open the FX Settings in the display. FX1 is configured on
the left display, FX 2 on the right one.

FX SELECT Button

The FX Settings stay open until the FX SELECT button is pressed again. When disengaged, the
FX SELECT button is dim.

FX Settings of FX Unit 1

The options in these FX Settings determine how you will use the FX Unit.
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4.3.2 FX Unit Assignment
 

In order to route a Deck's signal to an FX Unit, press the corresponding FX Assign button in the
mixer channel.

FX Assign Buttons

► In TRAKTOR's default setup with 2 FX Units, press the left FX button to assign the mixer
channel to FX Unit 1. Press the right FX button to assign the channel to FX Unit 2. The
FX assign buttons light up bright orange when assigned.

4.3.3 Additional FX Unit 3 and 4
 

By default, TRAKTOR is set up with two FX Units. In order to use all four of TRAKTOR'S FX
Units, you need to change the following setting:

► In TRAKTOR's Preferences, select Effects>FX Unit Routing>4 FX Units.

TRAKTOR's FX Unit Routing Preferences

If you activate 4 FX Units, S8's Performance controls are assigned to FX Units 3 and 4. They
work in a fashion very similar to the dedicated controls in FX Units 1 and 2.
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Controls for 4 FX Units

(1) FX Units 1 and 2 are available in any configuration.

(2) FX Units 3 and 4 are available once the 4 FX Units option is activated. They offer the same
features as units 1 and 2 by means of the Performance controls.

Assigning FX Units 3 and 4

To route a channel to FX Unit 3 or 4:

► Press SHIFT button + an FX assign button. The left FX assign button assigns to FX Unit
3, the right button to FX Unit 4.

FX Unit 2 has the same layout as FX Unit 1, apart from the FX SECTION button being lo-
cated in the top-right corner of the device.
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4.4 The Mixer
 

This is a brief overview of the mixer's layout, its function and operation. After that, the detailed
hardware reference explains each and every component found in S8's mixer section. The 4-
channel mixer sits at the center of both, S8, as well as TRAKTOR's software interface. When
connected to TRAKTOR, the knobs in S8's mixer section control the corresponding knobs on
the software mixer.

Hardware Reference

The Mixer

 

TRAKTOR KONTROL S8 - Manual - 201



S8's Mixer

Callout Description Link to section providing further information

(1) Mixer Channels A, B, C, D ↑4.4.1, Mixer Channel

(2) Mixer Main Section ↑4.4.2, Mixer Main Section
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S8's mixer comes with its own audio processor, which allows it to be used as a stand-alone
mixer with 3-band EQ and HP/LP Filter per Channel. The Decks and FX Units, on the other
hand, are tied to TRAKTOR software features and don't work in stand-alone operation.

Let's take a quick look at the mixer's key hardware controls and their software equivalents.

4.4.1 Mixer Channel
 

All mixer channels are laid out identically. Let's have a look at one of them.
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Mixer Channel Details

From top to bottom, a mixer channel consists of the following controls:

Number Description Links leading to section with further information

(1) GAIN knob ↑4.4.1.1, GAIN Knob

(2) TRAKTOR button ↑4.4.1.2, TRAKTOR Button

(3) FX Assign buttons ↑4.4.1.3, FX Assign Buttons
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Number Description Links leading to section with further information

(4) Input level meter ↑4.4.1.6, Channel Meter

(5) EQ (HI, MID, LOW) knobs ↑4.4.1.4, EQ Knobs

(6) FILTER button and FILTER knob ↑4.4.1.7, FILTER Button and FILTER Knob

(7) CUE button ↑4.4.1.8, CUE Button

(8) Channel fader ↑4.4.1.5, Channel Fader

4.4.1.1 GAIN Knob
 

The GAIN knob controls the level a channel receives from the corresponding Deck or audio in-
put.

GAIN Encoder

► Adjust the levels of tracks you want to mix or cross-fade between by turning the tracks'
GAIN knobs in order to avoid differences in loudness when mixing.

GAIN is applied after the INPUT and conversion to digital. So if you connect a turntable or
any other external device and your channel level meter is constantly moving beyond the
four orange segments with the GAIN knob in center position, dial back that device's output
level until only the loudest passages reach the orange range of the Input level meter.

4.4.1.2 TRAKTOR Button
 

Use this button bearing the TRAKTOR logo to switch a channel between TRAKTOR and Direct
Thru mode.

TRAKTOR Button
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Direct Thru mode allows you to use S8 as a stand-alone 4 channel mixer to mix turntables, CD-
Players and other sources, apply EQ and Filter to each channel and route them to the outputs.

TRAKTOR Button S8 Channel TRAKTOR Deck Audio source

TRAKTOR mode Connected to TRAKTOR Track Deck TRAKTOR Deck

" " Remix Deck TRAKTOR Deck

" " Live Input External source

Direct Thru mode Thru mode Direct Thru External source

 

If you're using the S8 without a computer connected, as a stand-alone mixer, the TRAKTOR
buttons are off.

A detailed look at using the S8 as a stand-alone DJ mixer in Thru mode is provided in chapter
↑4, Hardware Reference.

4.4.1.3 FX Assign Buttons
 

Each channel offers two FX Assign buttons which activate routing through TRAKTOR's FX
Units. Press the left one to route the channel to FX Unit 1, the right one to route to FX Unit 2.

FX Assign Buttons

These assignments aren't mutually exclusive, so you can send signal to either one or both FX
Units at the same time.

If you activate both FX assign buttons, your track will first run through FX1, then FX2.

TRAKTOR's FX only work if a channel is set to TRAKTOR mode. If you need to run an exter-
nal device through TRAKTOR's FX, set it to TRAKTOR mode and choose the Live Input Deck
flavor.
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Assigning FX Units 3 and 4

TRAKTOR supports up to 4 FX Units. Activate the two additional FX Units in TRAKTOR's pref-
erences: Preferences > Effects > FX Unit Routing > 4 FX Units.

To assign a channel to FX Unit 3 or 4:

► Press SHIFT + FX assign button. The left button assigns to FX Unit 3, the right one to FX
Unit 4.

► Control FX Units 3 and 4 via S8's Performance knobs and buttons.

4.4.1.4 EQ Knobs
 

Each channel sports a 3-band EQ section: HI, MID and LOW knobs allow you to restore the to-
nal balance between different tracks by increasing or decreasing the corresponding frequency
band's volume.

EQ Section

At the center position, the knobs have a detent, marking the position where the EQ doesn't
change the frequency balance.
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S8's internal EQ sounds identical to the Z ISO which is the default in the TRAKTOR soft-
ware.

TRAKTOR PROvides you with various types of EQ, each of them with its own “personality.”
You can choose the EQ type in Preferences > Mixer > EQ Selection.

4.4.1.5 Channel Fader
 

The channel fader controls the channel’s level being sent to the Crossfader and MAIN OUT.

Channel Fader

Use the fader to smoothly fade a channel into your mix.

A channel's fader setting doesn't affect its volume in the CUE - use the GAIN knob to bal-
ance its relative level and then pull the faders up to fade in.

4.4.1.6 Channel Meter
 

Use the channel meter's visual feedback to set up the optimal signal level. If your source is a
TRAKTOR Deck, simply adjust the GAIN knob.

If you connect external turntables or CD Players, use their volume knobs to set the correct
channel level. If S8's input starts clipping, lowering GAIN will make the channel quieter,
but it won't resolve clipping at the input.
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Increase level so that you get a steady movement of the blue segments and so that the loudest
passages of your track just barely push the level meter into the orange range. Don't worry, the
MAIN output has massive reserves to drive the P.A. even if you don't push the input as hard as
you can.

4.4.1.7 FILTER Button and FILTER Knob
 

The FILTER button is an on/off switch for the on-board dual-mode filter.

FILTER Section

To activate it, press the FILTER button. Then turn the FILTER knob to adjust the filter fre-
quency.

► Turn the knob to the left of the center position to activate a low-pass filter, which gradu-
ally attenuates more and more of the high frequencies.

► Turn the knob to the right to remove low frequencies.

Even if the FILTER button is engaged, when the FILTER knob is in its center position, no
filter is applied.

TRAKTOR provides you with different types of dual-mode filters. You can choose the filter
type in the Preferences>Mixer>Filter Selection.

4.4.1.8 CUE Button
 

Press the CUE button to send the channel’s signal to the cue channel in order to audition it
over your headphones.
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CUE Button

The channel fader doesn't affect the channel volume in the CUE. So please keep it down
until you're ready to fade the channel into your MAIN mix.

For a practical tutorial on using headphone controls in the mix, please refer to section ↑2.5.3,
Using Headphones to Prepare the Mix.

4.4.2 Mixer Main Section
 

This chapter gives a brief overview of the Mixer's Main section first and then an explanation of
every control element.
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Mixer Main Section Elements

 

Number Description Links leading to section with further information

(1) Crossfader ↑4.4.2.1, Crossfader

(2) CUE VOL knob ↑4.4.2.2, CUE VOL Knob

(3) CUE MIX knob ↑4.4.2.3, CUE MIX Knob

(4) TEMPO encoder ↑4.4.2.4, TEMPO Encoder
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Number Description Links leading to section with further information

(5) BOOTH knob ↑4.4.2.5, BOOTH Knob

(6) GLOBAL section ↑4.4.2.6, GLOBAL Section

(7) MIC assignment buttons ↑4.4.2.7, MIC 1 and 2 Buttons

(8) MAIN knob ↑4.4.2.8, MAIN Knob

4.4.2.1 Crossfader
 

The Crossfader controls the mix between the channel(s) assigned to its left and right side via
the Crossfader Assign Switches on S8's front panel.

The Crossfader

Adjust the cross-fading behavior to fit your performance via the XF CURVE knob:

The XF CURVE knob located at the front panel.

• Smooth transitions and mixing tracks: Turn XF CURVE all the way to the left. The cross-fad-
ing works gradually, which means that with the Crossfader in its center position, the left
and right sides are mixed equally.

• Scratching and Effects: Turn XF CURVE all the way to the right. The Crossfader works al-
most like a switch at its left and right ends.
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4.4.2.2 CUE VOL Knob
 

The CUE VOL knob adjusts the volume of the headphone output.

The CUE VOL Knob

S8's high power headphone amps deliver enough volume even in loud environments. Please
be careful and start with a low setting.

4.4.2.3 CUE MIX Knob
 

The CUE MIX knob determines whether you hear the MAIN mix only, the CUE channel only, or
a mix of both signals in your headphones.

CUE MIX Knob

Pre-hear a new track in your CUE and raise the channel's GAIN until the mix of both tracks
sounds good when the CUE MIX is in center position. That way, when you actually mix it in to
the MAIN, you can be certain that it blends well.

4.4.2.4 TEMPO Encoder
 

The central TEMPO knob controls TRAKTOR's Tempo Master in BPM. All synced Decks automati-
cally follow tempo changes.
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TEMPO Encoder

The TEMPO encoder changes tempo in increments of .01 BPM. Hold SHIFT to change in
increments of 1 BPM.

A shortcut provides tempo control functionality via the Deck's display.

Please note: you can only set an individual tempo for un-synced Decks. If you adjust a
synced Deck's tempo, the Tempo Master's BPM change along with it.

So for behavior similar to using a dedicated Tempo slider, make sure the Deck isn't synced.

1. Press Display Button 1 to open the BPM pop-up.
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2. Turn the BROWSE knob to adjust MASTER tempo in .01 BPM increments. To adjust in full
BPM steps, hold SHIFT while turning the knob.

→ The Track/Remix content playback speed is adjusted.

If you need to manually sync a Deck to an external source like a turntable, use the tempo ad-
justment in combination with the Deck's touch strip as described in section ↑3.1, Using Touch
Strip.

Note that for Decks which are either set as the MASTER Deck or are synced to MASTER, S8
displays MASTER CLOCK BPM. If the Deck in focus is not in sync with TRAKTOR's Master
Clock, the BPM overlay shows the Track Deck's or Remix Deck's individual BPM.

The BPM overlay can only be accessed on Track- or Remix Decks.

4.4.2.5 BOOTH Knob
 

The BOOTH knob allows you to send the MAIN signal to a second set of loudspeakers via the
BOOTH OUT connectors and control their volume independently of the volume set by the VOL-
UME knob. One common use is to have your own monitor speakers on stage, so you can control
their volume independently from the venue's P.A. system.

BOOTH Knob

The BOOTH knob works the same regardless of whether the mixer is being used in TRAK-
TOR mode, with a mixed setup, or as a stand-alone mixer.

4.4.2.6 GLOBAL Section
 

Snap and Quantize modes can be enabled/disabled directly from the S8 by pressing the corre-
sponding buttons S and Q buttons in the GLOBAL section.
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GLOBAL Section

These S8 controls only affect TRAKTOR's Decks.

Snap Button

The Snap button, labeled S, allows you to activate/deactivate Snap mode. With Snap mode ac-
tive, every Cue Point or Loop Point you set will snap to the closest beat.

Quantize Button

The Quantize Button, labeled Q, allows you to activate/deactivate Quantize mode. With Quan-
tize active, all skip actions within a track (Hotcues, Beatjumps, etc.) are beat-accurate.

If you trigger a jump before a beat, TRAKTOR delays the action so that the effect occurs on the
beat. This way, your track always stays in sync, allowing a perfect real-time remixing.

4.4.2.7 MIC 1 and 2 Buttons
 

S8 features MIC 1 and 2 inputs which allow you to connect dynamic microphones and route
them through TRAKTOR's effects and mixer by means of Live Input Decks.

MIC 1 and 2 Buttons

The MIC inputs are assigned to Deck C and D by default.

MIC inputs can only be activated on Decks which are currently not playing back, as they
are switched to Live Input mode in the process.
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► Press a MIC (1 or 2) button to activate the connected microphone. The MIC button and
the assigned channel's TRAKTOR button light up bright green when enabled.

► If the microphone can't be assigned to the channel you select, the TRAKTOR and MIC
buttons flash alternately.

Changing the channel assignment

1. Check the assignment by holding the MIC 1/2 button. The assigned channel's TRAKTOR
button lights up bright green. All channels you can assign the MIC to are marked dim
green.

2. Hold the MIC 1 button.
3. Press another channel's TRAKTOR button to assign the microphone to it.

→ If the assignment is successful, the newly assigned channel's TRAKTOR button lights
bright green.

For more information on connecting a microphone and setting up your S8 accordingly, refer
to section ↑5.6, Connecting Microphones.

4.4.2.8 MAIN Knob
 

The MAIN knob controls the overall output level of your mix going to S8's MAIN OUTs.

MAIN Knob

The LED meters to the left and right show the output level. If the MAIN knob is turned left
(towards its minimum value), the associated main level meters will go down, too.

Adjust the MAIN knob so that the loudest passages of your performance stay in the upper
part of the blue area without exceeding the orange LEDs
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4.5 The Rear Panel
 

The rear panel holds numerous connectors you can use to connect additional equipment such
as active speakers, microphones, turntables, or CD players.

Rear Panel Sections

Callout Description Link to section providing further information

(1) MAIN OUT ↑4.5.1, MAIN OUT

(2) BOOTH OUT ↑4.5.2, BOOTH OUT

(3) INPUT CHANNELS A-D ↑4.5.3, External INPUTs

(4) Ground post ↑4.5.3, External INPUTs

(5) MIC inputs ↑4.5.4, MIC Input Section

(6) Kensington Lock slot ↑4.5.5, Kensington Lock Slot

(7) MIDI IN/OUT sockets ↑4.5.6, MIDI Connectors

(8) USB socket ↑4.5.7, USB Connector

(9) POWER section ↑4.5.8, POWER Section

For technical details about all the connections see chapter ↑9, Technical Specification.
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4.5.1 MAIN OUT
 

MAIN OUT Section

The MAIN OUT section offers two sets of output sockets:

(1) Unbalanced RCA: connect the RCA outputs to practice with your home stereo or to another
DJ mixer or recording device.

(2) Balanced XLR: the balanced XLR outputs allow you to connect professional-grade cables
which are much more resistant to electrical interferences than unbalanced cables, especially
over longer distances. Connect XLR cables from the S8 to your active speakers or power amp.

4.5.2 BOOTH OUT
 

BOOTH OUT Section

The quarter-inch balanced BOOTH outputs carry the same signal as the MAIN OUT connectors
mix. The most common use for these outputs is connecting additional speakers on stage. Ad-
just the BOOTH OUT's level with the dedicated BOOTH knob located in the center of S8's mix-
er.
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4.5.3 External INPUTs
 

RCA INPUT Section

The INPUT Channel A-D connectors allow you to integrate your turntables, CD players, or any
external audio source you want to use during your performance. This section contains:

(1) LINE/PHONO switch: depending on the device you connect, set this switch to LN or PH.
Turntables usually require PH, all line level audio sources LN.

(2) Line/Phono Inputs RCA sockets: turntables, CD players, and line level audio sources can be
connected to these inputs using an RCA cable.

(3) Ground post: connect your turntables' grounding leads here to avoid humming noise.

For more information on using the S8 in combination with turntables (or CD players), and
TRAKTOR SCRATCH PRO 2 refer to section ↑5, Common Setups.
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4.5.4 MIC Input Section
 

MIC Input Section

The MIC section provides two microphone inputs:

(1) MIC 1 input (unbalanced): connect your microphone here via a standard 6.3mm (or 1/4-inch)
connector.

(2) MIC 2 input (balanced TRS): connect your microphone to this input via either XLR or bal-
anced 6.3mm (or 1/4-inch) connector.

For more information on connecting a microphone and setting up your S8 accordingly, refer
to section ↑5.6, Connecting Microphones.

4.5.5 Kensington Lock Slot
 

Kensington Lock Slot
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Use a Kensington-slot compatible lock to lock your S8 to a heavy object like a table to prevent
theft.

4.5.6 MIDI Connectors
 

MIDI Connectors

Connect external MIDI devices you want to integrate into your TRAKTOR KONTROL S8 setup.

4.5.7 USB Connector
 

USB Connector

Connect S8 to your computer here, using the included USB cable. The connection is USB 2,
but is compatible to USB 3-equipped computers.

Due to the large amounts of data transmitted to the TRAKTOR KONTROL S8, it may not
work properly when connected to a USB hub. Make sure to connect S8 directly to a USB
port on your computer if possible.
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4.5.8 POWER Section
 

POWER Section

In the POWER section, you make the connection to the power supply and to your computer:

(1) Power Supply connector (15V - 2.66 A): connect the included power supply.

(2) ON/OFF switch: press this switch to turn your device on or off.

Do not use the TRAKTOR KONTROL S8 with a power supply other than the one included in
delivery. In case of loss or damage, make sure to purchase a replacement power supply ap-
proved by Native Instruments for use with the S8.

Before you use the power supply and connect to the S8, please refer to the TRAK-
TOR KONTROL S8 IMPORTANT SAFETY INSTRUCTIONS leaflet (included in the box).
This leaflet explains how to attach the specific adaptor plug for your region.

4.6 The Front Panel
 

This section gives an overview of the elements on S8's front panel, then describes the connec-
tors, switches, and knobs in more detail.
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S8's Front Panel

Callout Description Link to section providing further information

(1) Crossfader Assign
switches

↑4.6.1, Crossfader Assign Switches

(2) Crossfader Curve
Knob

↑4.6.2, Crossfader Curve Knob

(3) PHONES Section ↑4.6.3, PHONES Section

4.6.1 Crossfader Assign Switches
 

Crossfader Assign Switches

Each channel can be assigned to either the left or right side of the Crossfader. The center posi-
tion (THRU) lets the channel bypass the Crossfader altogether.
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4.6.2 Crossfader Curve Knob
 

XF CURVE Knob

This knob changes the crossfader curve. Different scenarios require different curves:

Smooth transitions and mixing tracks: Turn XF CURVE all the way to the left. The cross-fading
works gradually, which means that with the Crossfader in its center position, the left and right
sides are mixed equally.

Scratching and Effects: Turn XF CURVE all the way to the right. The Crossfader works almost
like a switch at its left and right ends.

You can also customize the fading curve of the Crossfader in Preferences > Mixer > Cross-
fader.

4.6.3 PHONES Section
 

PHONES Section
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The PHONES section offers two headphones connectors. You can audition tracks via the CUE,
as well as listen to the MAIN mix.

(1) Small Headphone Jack: Connect 3.5 mm (1/8-inch) stereo headphone plugs.

(2) Large Headphone Jack: Connect 6.3 mm (1/4-inch) stereo headphone plugs.

Adjust the Headphone levels with the CUE VOL knob on S8's top panel.
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5 Common Setups

 

In addition to being a fully integrated TRAKTOR controller and audio interface, S8 can work in
a mixed setup with turntables or CD players and can even serve as a pure 4-channel DJ mixer
without any connection to TRAKTOR.

This chapter provides setup information for these different scenarios as well as how to connect
microphones.

In order to make use of TRAKTOR's SCRATCH functionality by using turntables or CD Play-
ers, additional Timecode vinyl or CDs are required. These are not included in the S8 prod-
uct box, but can be purchased separately from the Native Instruments website

Prerequisites

• The TRAKTOR SCRATCH PRO 2 software is installed and activated as described in the
TRAKTOR KONTROL S8 Setup Guide.

• The S8 is set up as described in the TRAKTOR KONTROL S8 Setup Guide.

• The S8 is switched off and its Power Supply is disconnected from the power socket.

• The amplification system or active speakers connected to the S8 are switched off.

• All channel faders and volume knobs on the S8 are turned to minimum position.

If you intend to connect turntables to the S8, refer to section ↑5.1, Connecting Turntables.

If you intend to connect CD Players to the S8, refer to section ↑5.2, Connecting CD Players.

5.1 Connecting Turntables
 

To integrate your turntables in your TRAKTOR set:
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1. Connect your turntables to any of the Line/Phono INPUTS A – D on the rear panel of the
S8 using a stereo RCA cable.
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2. Attach the ground wires of your turntables to the ground post GND on the rear panel of
the S8.

3. Set the respective channel's LINE/PHONO switch to PH.

→ The turntables are ready for use.

The channel meter displays the input level independently of the channel fader setting. Ide-
ally, always set input level with the channel fader all the way down.

If you want to use S8 as stand-alone DJ mixer, refer to section ↑5.5, Using Your S8 as a
Stand-alone DJ Mixer.
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If you want to use your turntables as Timecode control, refer to section ↑5.4, Integrating Exter-
nal Sources as TIMECODE Controls.

5.2 Connecting CD Players
 

To include CD players in your TRAKTOR set:

1. Connect your CD players to any of the Line/Phono INPUTS A – D on the rear panel of the
S8 using a stereo RCA cable.

2. Set the respective channel's LINE/PHONO switch to LN.

→ The CD players are ready for use.
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The channel meter displays the input level independently of the channel fader setting. Ide-
ally, always set input level with the channel fader all the way down.

If you want to use S8 as a stand-alone DJ mixer, refer to section ↑5.5, Using Your S8 as a
Stand-alone DJ Mixer.

If you want to use your CD players as Timecode control, refer to section ↑5.4, Integrating Ex-
ternal Sources as TIMECODE Controls.

5.3 Integrating External Audio Sources in your TRAKTOR Workflow
 

With turntables or CD players connected to a channel, you can either route them through
TRAKTOR in order to add FX via a Live Input Deck, or mix them directly in S8's mixer in Direct
Thru mode.

By pressing the respective channel's TRAKTOR button, you can switch between Live Input
mode and Direct Thru mode in real time. While FX can only be assigned in Live Input
mode, the 3-band EQ and Filter are available in both.

5.4 Integrating External Sources as TIMECODE Controls
 

As soon as the turntables or CD Players are connected to the S8 correctly, there are some final
steps to complete your TRAKTOR SCRATCH setup.

For a detailed description of how to work with TRAKTOR SCRATCH PRO 2, please refer to
chapter 12 in the TRAKTOR Manual.

5.4.1 Final Preparations with Turntables
 

To complete your TRAKTOR SCRATCH setup with the S8:

1. Connect the S8's Power Supply to the Power socket.
2. Switch on the S8.
3. Switch on your amplification system or active speakers.
4. Start TRAKTOR on your computer.

Common Setups

Integrating External Audio Sources in your TRAKTOR Workflow

 

TRAKTOR KONTROL S8 - Manual - 231



5. For the designated SCRATCH Decks, press the TRAKTOR buttons on the S8 to enable
TRAKTOR mode. This is essential to engaging SCRATCH Control.

6. In the TRAKTOR software, click on the down arrow below the Deck letter to open the
drop-down menu.

7. Select Scratch Control.

 
On TRAKTOR's Decks, the CUE and CUP buttons are replaced with Absolute mode and
Relative Mode buttons.

8. Put the TIMECODE Control Vinyls on your turntables.
9. Use the S8 to load tracks into the Decks you have just assigned to Scratch Control.
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10. Start the turntables, and drop the needles on the TIMECODE Control Vinyl.

→ The calibration process is performed automatically.

5.4.2 Final Preparations with CD Players
 

To complete your TRAKTOR SCRATCH setup with the S8:

1. Connect the S8's Power Supply to the Power socket.
2. Switch on the S8.
3. Switch on your amplification system or active speakers.
4. Start TRAKTOR on your computer.
5. For the designated SCRATCH Decks, press the TRAKTOR buttons on the S8 to enable

TRAKTOR mode. This is essential to engaging SCRATCH Control.

6. In the TRAKTOR software, click on the down arrow below the Deck letter to open the
drop-down menu.

Common Setups
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7. Select Scratch Control.

 
On TRAKTOR's Decks the CUE and CUP buttons are replaced with Absolute mode and
Relative Mode buttons.

8. Insert the Control CDs in your CD players.
9. Use the S8 to load tracks into the Decks you have just assigned to Scratch Control.
10. Trigger playback of the tracks using the CD players.

→ The calibration process is performed automatically when you trigger playback for the first
time.

5.4.3 Successful Calibration
 

TRAKTOR detects which Timecode medium you are using, verifies the signal quality, and if the
signal quality is adequate it completes the calibration process. The software platters will then
spin at the same speed as the turntables; and the movement of the record will be followed ex-
actly.
In general, we recommend you always check the Scope panel when setting up TRAKTOR
SCRATCH PRO 2, to ensure Timecode control is working properly.

You can open the Scope panel by clicking on the platter, or, if the platter is not shown in the
software, by clicking on the small arrow (minimize button) above the Timecode quality meter.

The small arrow (minimize button) above the quality meter will also minimize the Scope
panel for a larger view of the track's waveform.

The diagram below shows an example of a successful calibration with control vinyl, with the
four indicators shown in the Scope panel:
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The four indicators on the Scope panel.

(1) The Scope offers a circular representation of the incoming Timecode signal. If the calibra-
tion is successful, there is a blue outer circle and an orange diagonal line.

(2) The quality meter is on the right side. After a successful calibration, this is completely or-
ange.

(3) The stereo input level meter is on the bottom right. After a successful calibration, these two
channels are about halfway up.

(4) The status information at the bottom center.

The CALIBRATE button resets Timecode calibration. This is done automatically when you start
TRAKTOR.

Successful calibration using a Control MK2 CD
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In a mixed setup with one turntable and one CD player, simply connect them as explained
above. Remember to ensure that the LINE/PHONO switches are set accordingly, and mixer
channels' TRAKTOR buttons are bright orange—to indicate they are set to TRAKTOR mode.

If you have followed the information in this chapter and are still having difficulty getting
the timecode vinyl or CD to successfully calibrate your decks, you will find detailed infor-
mation on TRAKTOR SCRATCH and helpful troubleshooting information contained in the
TRAKTOR 2 Manual.

5.5 Using Your S8 as a Stand-alone DJ Mixer
 

For using turntables or CD Players with S8 as a stand-alone DJ Mixer setup, follow the instruc-
tions given in this section:

Prerequisites

• The S8 is not connected to your computer.

Final preparations

1. Connect the S8's Power Supply to the Power socket.
2. Switch on the S8.
3. Switch on your amplification system or active speakers.
4. Assign the channels to a side of the Crossfader.
5. Turn on your turntables or CD Players.
6. Put the vinyl on your turntables or insert CDs into your CD Players.
7. Start mixing.
8. Slowly turn up the MAIN knob until the volume is at the desired level.

→ The S8's corresponding channel meters will light up to show the audio signal they are re-
ceiving.

If you still can't hear anything, check that:

• The GAIN knobs (at the top of channels A - D) are raised.

• The channel faders are raised.

Common Setups
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• The FILTER and EQ band knobs (HI, MID, LOW) are in center position.

Although you can change TRAKTOR's internal EQ and filter characteristics, it is not possi-
ble to change the EQs and filters in stand-alone operation.

5.6 Connecting Microphones
 

Connecting a microphone allows you to expand the scope of your performance. You can talk to
your audience or integrate a beat boxing routine, as well as process your vocals or that of a
vocal artist with TRAKTOR's internal FX. For connecting microphones to the S8 and assigning
them to channels, read the following section.

To connect microphones to your S8:

► Plug your microphone(s) into the MIC 1 or MIC 2 sockets on the rear panel of the S8.

Common Setups

Connecting Microphones

 

TRAKTOR KONTROL S8 - Manual - 237



5.6.1 Checking Microphone Assignments
 

By default, the S8 assigns MIC 1 to mixer channel C, and MIC 2 to channel D. To check the
assignment of microphone 1:

► Hold the MIC 1 button.

→ Channel A and B's TRAKTOR buttons light up dim green, indicating that the MIC is as-
signable to them. Channel D's button is off, indicating the channel which MIC 2 input is
already assigned to. Channel C's TRAKTOR button lights up bright green, indicating the
current assignment.

5.6.2 Assigning a Microphone to another Channel
 

S8's two MIC Inputs can be freely assigned to any of the four channels. To assign microphone
1 from Channel C to Channel A:
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1. Hold the MIC 1 button.

 
Channel A and B's TRAKTOR buttons light up dim green, indicating that the MIC can be
assigned to them.

2. Press channel A's TRAKTOR button. This button becomes bright green now.

3. Release the MIC 1 button.

→ You have now assigned the MIC 1 input to channel A.

You cannot assign two MIC ins to the same channel. If you need to assign a MIC input to a
channel which already has a MIC input assigned to it, re-assign the second MIC input first.

5.6.3 Switching between Live Input and Direct Thru
 

After assigning the MIC Input to a channel, that channel is automatically set up as a Live Input.

► Press the channel's TRAKTOR button to toggle between sending the MIC signal into
TRAKTOR (Live Input) and mixing it directly inside S8's mixer (Direct Thru).

In Live Input mode, you can process your microphone signal with TRAKTOR's FX Units, allow-
ing you to add performance effects.
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In Direct Thru mode, the microphone signal is not sent to the computer. Instead, it is mixed
directly in S8's mixer, solving any latency issues you might have at the expense of not being
able to add FX.

In Direct Thru mode, TRAKTOR's FX Units don't have any effect on the signal, but the 3-
band EQ and the Filter are still available.

5.6.4 Activating a MIC Input
 

Before activating the microphone for the first time, please lower the channel fader to pre-
vent sudden bursts of noise from your speakers or headphones when activating the MIC In-
put.

► Activate the microphone by pressing the MIC 1 button.

→ The microphone is ready for use.

Deactivating a Microphone

With MIC 1 input active:

► Deactivate the microphone by pressing the MIC 1 button again.
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6 Preferences Pane in TRAKTOR

 

Once configured via the Setup Wizard, a dedicated pane for S8 is added to TRAKTOR's Prefer-
ences window, which lets you configure the behavior of the touch controls, as well as overall
LED brightness for the back-lit buttons and the Loop and Beatjump Sizes assigned to each
Deck's pads.

The S8 pane in TRAKTOR's Preferences

Preferences Pane in TRAKTOR
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6.1 Restore Default
 

This button recalls all factory default settings for the TRAKTOR KONTROL S8 and lets you
choose its basic deck configuration via the Setup Wizard.

6.2 Touch Controls
 

A number of controls are sensitive to touch. TRAKTOR lets you activate touch functions, which
will save you the dedicated press of a button for a few features.

• Auto Open Browser on Touch: If activated, touching a BROWSE knob will open the Brows-
er, after letting go, it will automatically close. If deactivated, press the BROWSE knob to
open the Browser.

• Auto Open FX Panels on Touch: If activated, touching the FX knobs overlays an FX panel
with information about the knobs' parameter values, as well as the adjacent FX buttons'
functions. If deactivated, you can still control the parameters, but no panel is opened.

• Auto Open Performance Control on Touch: If activated, touching the Performance knobs
below the display overlays a Performance panel with information about the knobs' param-
eter values, as well as the adjacent Performance buttons' functions. If deactivated, you
can still control the parameters, but no panel is opened.

If FX Units 3 and 4 are activated, touching the Performance knobs opens the FX panel for
FX Unit 3 and 4, instead of the Performance panel. The Auto Open Performance Control on
Touch setting activates the touch sensing of these knobs, no matter which function they
control.

Preferences Pane in TRAKTOR
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6.3 Touchstrip
 

Touch technology relies on the electrical properties of your skin, which differ from one person
to another. The default value will work for most people under most conditions. However, if you
feel the touch strips should react more sensitively, or start registering too soon, you can adjust
the behavior here.

• Bend Sensitivity: by default set to 50%; adjust the Tempo bend sensitivity and check in
real time if the change accommodates you better.

• Scratch Sensitivity: by default set to 50%; adjust the Scratch sensitivity and check in real
time if the change accommodates you better.

• Bend Invert: by default deactivated; swiping to the left slows playback down momentarily.
If activated, swiping to the left nudges playback forward.

• Scratch Invert: by default activated; swiping to the left advances playback position in the
track. If deactivated, swiping to the left goes back in a track.

• Shift + Touch to Scratch: by default deactivated, holding the SHIFT button +swiping
within the Touch Strip performs an absolute seek. If activated, holding the SHIFT button
+swiping within the Touch Strip performs a scratch effect or backspin.

6.4 Calibrate
 

Calibration ensures that each control allows adjustments over their full range and with maxi-
mum precision. These settings are precisely calibrated during production, although they might
need to be recalibrated over the lifetime of your S8 unit. Recalibration is necessary when a
control ceases to allow you to set actual minimum and maximum values.

Calibration is done in groups of control elements, just click the corresponding Recalibrate but-
ton:

• FX Knobs: for recalibrating the FX knobs on both FX Units 1 and 2.

• Short Faders: for recalibrating the Slot Volume Faders.

• Mixer Knobs: for recalibrating EQ (HI, MID, LOW) and FILTER knobs.

Preferences Pane in TRAKTOR
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• Mixer Fader: for recalibrating the channel faders.

• Crossfader: for recalibrating the Crossfader.

6.5 LEDs
 

The pad and button backlights on the S8 offer two distinct brightness levels to indicate On and
Off states. Depending on your light conditions during a performance, it can be necessary to ad-
just these.

On State Brightness: sets the brightness level for engaged buttons and pads.

Dim State Percentage: sets the brightness level for inactive buttons and pads.

6.6 Loop Mode Sizes
 

When a Deck is in Loop Mode, the corresponding pads are split into two rows. The top row rep-
resents four Loop sizes, and the bottom row four Beatjump sizes. Here, you can adjust these
settings to suit your needs.

• Loop: For each of the upper four pads, you can select a Loop size of: 1/32, 1/16, 1/4,
1/2, 1, 2, 4, 8, 16, 32 beats via drop-down menus.

• Beatjump: For each of the four lower pads you can select a Beatjump size of: - LOOP, -
32, - 16, - 8, - 4, - 2, - 1, -/2, -/4, -/8, -/16, +/16, +/8, +/4, +/2, +1, +2, +4, +8, + 16, +
32, +LOOP.

6.7 Enable MIDI Controls
 

The TRAKTOR KONTROL S8 allows you to use the Performance Knobs, Performance Buttons,
and the Performance Faders below the Display as MIDI output controls. You can use these
controls to send MIDI messages to other software or external equipment. This feature is not
enabled by default and requires some configuration.

To enable MIDI Controls for the S8:

1. In the TRAKTOR window click File, then Preferences to open the preferences window.

Preferences Pane in TRAKTOR
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2. Navigate to the Traktor Kontrol S8 page. There, check the Enable MIDI controls prefer-
ence in the MIDI Controls section.

Preferences with MIDI Controls enabled.

To assign the MIDI message and MIDI channel to the various MIDI controls:

1. Select Controller Manager tab in the Preferences.
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2. Click the Add... button and select Generic MIDI from the list to create a new Generic
MIDI Device.

3. In the upper-right corner, select the MIDI port to use as the output for this Generic MIDI
device.
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4. Click the Add Out... button.

5. Navigate to Global > MIDI Controls >….
Here you can assign the MIDI message and MIDI channel to the various MIDI controls.
You will find a list of Knobs, Faders, and Buttons. The first four entries in each category
correspond to the left Deck side (assigned to Decks A and C), while the last 4 knobs, fad-
ers, and buttons correspond to the right Deck side (assigned to Decks B and D).
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6. Select an entry to add it to the mapping.

7. Click the Device Mapping drop-down menu to show a list of 16 MIDI Channels. Hover
your mouse over the desired MIDI output channel’s entry. A sub-menu holding message
types CC, Note, and Pitch Bend will open. You can select Pitch Bend to map the MIDI
Pitch Bend message to this control, or you can hover your mouse over one of the other two
menus to show a list of specific CC and Note numbers and names. You can then click one
of these to map the control to the specified Note or CC.
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8. Repeat the above two steps for each of the MIDI controls you want to map.
9. Close the Preferences by clicking Close.
To switch the Performance Controls into MIDI Mode on the S8:

► Press the Performance Mode buttons next to the display until the MIDI page appears.

► Touch a Performance knob to enlarge the MIDI pane displaying current parameters of the
selected MIDI controls.

Preferences Pane in TRAKTOR
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The MIDI page will not appear if the above Enable MIDI controls preference is not turned on.

When the MIDI mode is enabled on the S8, the Performance Knobs and Buttons will out-
put the MIDI messages that you assigned in the Controller Manager. If you intend to assign
the Slot Volume Faders to output MIDI messages, make sure neither of the Decks control-
led by the S8 is a REMIX Deck. Otherwise the Slot Volume Faders will still control the Re-
mix Slot volumes instead of outputting MIDI.
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7 The S8 Audio Interface and Control Panel

 

Your TRAKTOR KONTROL S8 comes with an integrated high-end 24-bit/48 kHz audio inter-
face. You can adjust the audio interface settings to your needs and computer performance.
This section covers the setup on Windows and Mac OS X.

7.1 Settings on Mac OS X
 

On Mac OS X, you can adjust the settings for the S8 audio interface from within each music
application. In TRAKTOR:

► Open Preferences > Audio Setup to access the settings for the S8 audio interface.

There, adjust S8's audio interface settings, most importantly the latency:

Latency : Lower this value for a quicker response to hardware interactions like playing a Remix
Cell by pressing one of S8's pads.

When converting audio information to digital and vice versa, the audio driver needs to store
data in buffers to prevent the audio from cutting off. High buffer size settings will cause a
delay between an interaction and the change being audible, called latency. Low buffer
sizes will put more strain on the CPU and may lead to audio drop-outs. Find the best bal-
ance by setting Latency high, starting playback and lowering it until you encounter the first
audible crackles and pops. Now increase the value again until the crackling disappears.

7.2 Settings on Windows: The Control Panel
 

On Windows, access the settings for the TRAKTOR KONTROL S8 audio interface via the
TRAKTOR KONTROL S8 Control Panel application. The Control Panel is automatically instal-
led along with the S8 drivers during the TRAKTOR installation procedure.

This section describes the TRAKTOR KONTROL S8 Control Panel user interface.

The S8 Audio Interface and Control Panel
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7.2.1 Opening the Control Panel
 

You can open the Control Panel in various ways:

► From within TRAKTOR: Go to Preferences > Audio Setup and click the Settings button,
located at the right of the Latency slider and display:

Opening the Control Panel from inside TRAKTOR's Preferences

► From your desktop: Go to Start > Programs > Native Instruments > TRAKTOR KON-
TROL S8 > TRAKTOR KONTROL S8 Control Panel.

If you cannot find the Control Panel, the driver is most likely not installed at all. In this case,
please re-install the latest version of TRAKTOR and make sure the S8 driver is selected for in-
stallation.

7.2.2 Audio Settings Panel
 

The Audio Settings page allows you to adjust the settings of the audio interface.

The S8 Audio Interface and Control Panel
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Audio Settings pane in S8's Control Panel application

Audio Processing Section

This section provides settings for the analog-to-digital/digital-to-analog conversion done by your
audio interface.

Process Buffer : Lower this value for a quicker response to hardware interactions like playing a
Remix Cell by pressing one of S8's pads.

When converting audio information to digital and vice versa, the audio driver needs to store
data in buffers to prevent the audio from cutting off. High buffer size settings will cause a
delay between an interaction and the change being audible, called latency. Low buffer
sizes will put more strain on the CPU and may lead to audio drop-outs. Find the best bal-
ance by setting Latency high, starting playback and lowering it until you encounter the first
audible crackles and pops. Now increase the value again until the crackling disappears.

USB Buffer: Use this menu in case you cannot achieve satisfactory Latency settings with the
Process Buffer alone. Lower the USB buffer size for smaller USB buffer packaging, which
should further reduce the audible latency. If you notice any audio drop-outs, you should raise
the buffer size until you have a clear sound.

The S8 Audio Interface and Control Panel
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Device Monitor Section

This section displays information about the audio interface's processing status and your sys-
tem's output latency.

Processing State : The processing state monitor provides feedback on the current status of the
device. There are three possible status messages:

• Idle: controller is connected, but no audio data is being streamed.

• Streaming: driver is working and processing audio data.

• Panic: driver stopped streaming. Too many USB I/O errors occurred in the interface com-
munication.

Output Latency : displays your system’s output latency in milliseconds.

Please note, when running external sources like turntables or microphones through TRAK-
TOR, an additional input latency will occur.

7.2.3 Diagnostics Panel
 

The Diagnostics page allows you to monitor the controller’s performance and to detect errors.
This information can be helpful to see the results of Process Buffer value adjustments and may
help troubleshooting in case you need to contact our technical support.

The S8 Audio Interface and Control Panel
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Diagnostics panel in S8's Control Panel application

Drop-Out Detection Section

This section provides data for troubleshooting:

USB I/O Errors: Counts USB data transfer interruptions between your computer and S8.

Buffer Underruns: Buffer underruns occur when your computer isn’t able to process an audio
stream in time. Reasons for underruns can be too many devices communicating on the USB
bus at the same time or too high CPU load.

Reset: Click this button to reset the error count.

The S8 Audio Interface and Control Panel
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Connection Monitor Section

This section provides USB connection information:

Number of Clients: Displays the number of clients connected to the interface. Multiple ASIO
applications are counted separately, WDM and WASAPI increase the number by one, no matter
how many WDM/WASAPI applications play audio.

USB Data Errors: Counts USB data errors. Poor quality or too long cables, as well as interfer-
ence, can be the source of data errors on the USB bus.

Reset: A click on this button resets the error count.

System Performance Test Section

This section provides real-time measurements of the latency introduced by Windows itself.
This data can give clues about the sources of bad performance.

Current Latency: Displays the real-time value for Windows' internal latency. Monitor this value
as you launch and quit applications and connect or disconnect USB devices.

Maximum Latency: Display the maximum value since the last reset. Comparing the difference
between Maximum and Current Latency can help find the sources of sudden CPU peaks.

Reset: Resets the Maximum Latency value.

Stop: Pauses the measurement process. Click again to continue measurement.

Information Section

Information: Provides information about whether or not your driver and firmware are up to date.

Driver Version: See the currently installed driver version here.

Firmware Version: See the currently installed firmware version here.

Troubleshooting Guide: Click Show to open the Troubleshooting Guide.

The S8 Audio Interface and Control Panel
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7.3 Using the S8 Audio Interface with Other Music Applications
 

S8’s on-board audio interface can be used in any other music application installed on your
computer. To do this, you need to configure your music applications accordingly. Most music
applications offer a setting in their options or preferences allowing you to select the TRAK-
TOR KONTROL S8 as the audio interface. For more info, please refer to the documentation of
your music application.

7.4 Setting up S8 as your Default Audio Interface
 

S8 can function as your system's default playback device for all sound including system
sounds (not only for music software). This section describes how to configure the system set-
tings.

7.4.1 Windows
 

For Windows 7 (and later) you can define the TRAKTOR KONTROL S8 as your default audio
interface as follows:

1. Open Start > Control Panel > Hardware and Sound > Sound.
2. Select the Playback tab.
3. In the device list, select TRAKTOR KONTROL S8 WDM Audio and click Set Default.
4. Select the Recording tab.
5. In the device list, select TRAKTOR KONTROL S8 WDM Audio and click Set Default.
6. Click OK to close the dialog.

7.4.2 Mac OS X
 

For Mac OS X, you can define the TRAKTOR KONTROL S8 as your default audio interface as
follows:

1. From the Apple menu, select System Preferences.
2. In the panel that opens, click Sound.

The S8 Audio Interface and Control Panel
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3. On the Sound Effects tab, select TRAKTOR KONTROL S8 in the Play alerts and sound
effects through menu.

4. Click the Output tab, and select TRAKTOR KONTROL S8 from the Select a device for
sound output list.

5. Click the Input tab, and select TRAKTOR KONTROL S8 from the Select a device for
sound input list.

6. Close the window to confirm your changes.

The S8 Audio Interface and Control Panel
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8 Troubleshooting - Getting Help

 

This chapter covers the most common issues. Most of what can go wrong when setting up and
using TRAKTOR KONTROL S8 should be listed here along with some tried-and-tested ways to
solve these issues.

8.1 Troubleshooting
 

There are a few things you should check in case S8 doesn't work with your system.

8.1.1 TRAKTOR Won’t Start
 

• Check the system requirements for TRAKTOR KONTROL S8. Meeting the minimum re-
quirements ensures that TRAKTOR will work, but advanced use (i.e. Keylock, FX) may re-
quire a more powerful system.

• Launch the Service Center application and make sure you have the most recent TRAKTOR
version installed.

• Make sure that you haven't double-clicked an outdated application alias/shortcut.

• Try to restart your computer. Disconnect any other audio interfaces and computer periph-
erals like printers, scanners, and the like to see if that solves the problem.

• Try to rename the file collection.nml in the TRAKTOR 2 Root folder and restart TRAKTOR.
This way, TRAKTOR will create a blank Collection. Re-import the renamed .nml file to re-
store your Collection.

The Root folder is located in:

Windows: \My Documents\Native Instruments\Traktor 2\

Mac OS X: YourUserFolder/Documents/Native Instruments/Traktor

8.1.2 TRAKTOR Crashes
 

In case of a crash during operation, please contact the Native Instruments technical support
team and send them your crash log. You will find the crashlog in the following folders:
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• Windows: \My Documents\Native Instruments\Traktor 2\Crashlogs\

• Mac OS X: YourUserFolder/Library/Logs/CrashReporter/

8.1.3 TRAKTOR Has Performance Issues
 

Please check if your computer is suited for handling real-time audio processing without drop-
outs. The TRAKTOR KONTROL S8 Control Panel application offers a tool for measuring Sys-
tem Performance and for monitoring the number of audio dropouts, which cause audible click-
ing noises.

These steps are recommended to optimize your laptop’s audio performance:

• Increase the Process Buffer value in TRAKTOR'S Preferences > Audio Setup > Settings.

• If possible, don't run the laptop on battery power, as the computer's power management
will dynamically adjust the clock rate of the CPU in order to conserve battery.

• If your laptop has a shared memory graphics card, please ensure your system has more
RAM than listed in the System Requirements.

• Disconnect all unused hardware (e.g. printer, scanner). This will increase the amount of
processing power available for your music software.

• Make sure that S8 is connected directly to the computer via the included USB cable. The
use of USB hubs is not recommended.

• A bad USB cable can be responsible for connectivity problems. Try using a different cable
bearing the official USB logo to see if your cable is the cause of the issues.

• Laptops are often equipped with built-in devices that disturb audio processing, most com-
monly a network adapter or a wireless LAN card. You might need to disable these devices
while working with S8.

Windows users: The Online Knowledge Base contains additional tuning tips for your operating
system. See the following articles:

• Windows 7 tuning tips for audio processing:
http://www.native-instruments.com/knowledge/questions/847/

• Windows 8 tuning tips for audio processing:
http://www.native-instruments.com/knowledge/questions/1395/
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8.1.4 Updates
 

Whenever you encounter problems, it is recommended that you first download and install any
available software updates in Service Center or on our website:

http://www.native-instruments.com/updates

Updates are released regularly to fix known problems, maintain compatibility with operating
system updates, and to continuously improve the software.

8.2 Getting Help
 

If you are experiencing problems related to your Native Instruments product that the supplied
documentation does not cover, there are several ways of getting help!

The links in the following sections are also accessible from the Service Center application:

► Open the Service Center application and click on the Support button in the upper-right
corner.

8.2.1 Knowledge Base
 

The Online Knowledge Base gathers useful information about your Native Instruments product
which helps solve issues you may have. You will find the Knowledge Base at:

http://www.native-instruments.com/knowledge

8.2.2 Technical Support
 

If no Knowledge Base entry matches your problem, or if the matching entry does not solve the
problem, you can use the Online Support Form to contact the Technical Support team of Na-
tive Instruments. The Online Support Form will ask you to enter information about your hard-
ware and software setup. This information is essential for our Support team to be able to pro-
vide you with quality assistance. You can reach the Online Support via:

http://www.native-instruments.com/suppform
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When communicating with the Native Instruments support team, keep in mind that the more
details you can provide about your hardware, your operating system, the version of the software
you are running, and the problem you are experiencing, the better they will be able to help you.
In your description, you should mention:

• How to reproduce the problem

• What you have already tried to fix the problem

• A description of your setup, including all hardware

• The brand and specifications of your computer

• The software version number

The version number of your software is displayed in the TRAKTOR splash screen you see
when the application launches. After startup, the same splash screen can be opened by
clicking the TRAKTOR logo in the upper right corner of the user interface.

When installing new software or software updates, a Readme file is included that contains last
minute information that was not yet included in the documentation. Please open and read this
Readme file before contacting Technical Support.

8.2.3 Registration Support
 

If problems occur during the product activation procedure, please contact our Registration

Support team:

http://www.native-instruments.com/suppform

8.2.4 User Forum
 

In the Native Instruments User Forum, you can discuss product features directly with other
users and with experts moderating the forum. Please be aware that the Technical Support
team does not participate in the forum. If you’re encountering an issue that can’t be solved by
other users, contact Native Instruments’ Technical Support team via the online support form
as described above. Find the User Forum at:

http://www.native-instruments.com/forum
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9 Technical Specification

 

Input/output connectors

A-D: Four pairs of RCA input connectors

MIC 1: One 6.3 mm (1/4") TRS (balanced) microphone input connector

MIC 2: One combo XLR jack or 6.3 mm (1/4") TRS (balanced) microphone connector

BOOTH OUT: Two balanced 6.3 mm (1/4") TRS line out connectors

MAIN OUT: Two balanced XLR outputs

MAIN OUT: Two RCA outputs

PHONES: One stereo 6.3 mm (1/4") headphone output

PHONES: One stereo 3.5 mm (1/8") headphone output

MIDI (IN/OUT) Two 5-pin DIN connectors

GND: One ground terminal screw

K: One Kensington lock slot

USB: One USB 2.0 Type B connector

POWER: One power supply connector

Audio Specifications

Audio Inputs (A/D)  

Channels 4 Stereo

Sample Rate 48 kHz

Bit Resolution 24-bit

Converter Cirrus Logic
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Line Inputs  

Full Scale Level +13 dBu

DNR (a-weighted) 113 dBu

THD+N 0.001%

Frequency Response 20 Hz – 20 kHz (±0.1 dB)

Cross talk @ 1kHz -116 dB

 

Microphone Inputs  

Full Scale Level @ 1 kHz -7.2 dBu

DNR (a-weighted) @ 1 kHz 104 dB

THD+N @ 1 kHz 0.006%

Frequency Response 20Hz - 20kHz (±0.6 dB)

 

Phono Inputs  

Input impedance 47 kΩ

Full Scale Level @ 1 kHz -23.8 dBu

DNR (a-weighted) @ 1 kHz 84 dB

THD+N @ 1 kHz 0.002%

Crosstalk @ 1kHz -105 dB

 

Audio Outputs (D/A)  

Channels 2 Stereo

Sample Rate 48 kHz

Bit Resolution 24-bit

Converter Cirrus Logic
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Line Outputs (XLR & 1/4'' Booth)  

Max Output Level +20 dBu

DNR (a-weighted) 108 dB

THD+N @ 1kHz 0.001%

Frequency Response 20 Hz – 20 kHz (±0.2 dB)

Crosstalk @ 1kHz -115 dB

 

Line Outputs (RCA)  

Max Output Level +14 dBu

DNR (a-weighted) 108 dBu

THD+N @ 1kHz 0.001%

Frequency Response 20 Hz – 20 kHz (±0.1 dB)

Crosstalk @ 1kHz -117 dB

 

Headphones Outputs  

Load Impedance 16 Ω – 600 Ω

Max Output Level (32 Ω load) +7.2 dBu

DNR (a-weighted) 109 dB

THD+N @ 1kHz 0.07 %

Frequency response ±1 dB 20 Hz – 20 kHz (±0.2 dB)

Crosstalk @ 1kHz -63 dB

Power Supply

• Input: 100-240VAC, 50/60Hz, 1.5A

• Output: 15VDC, 2660mA
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Dimensions and Weight

• Depth: 38.7 cm

• Height: 6.6 cm

• Width: 58.5 cm

• Weight: 5 kg

Environmental Specifications

• Operating temperature: +5 to +35 °C (41 to 95 °F), max 85% non-condensing humidity

• Storage temperature: 0 to 40 °C (32 to 104 °F), max 85% non-condensing humidity

Do not install this unit in locations exposed to high humidity or direct sunlight.
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